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Introduction

IBM® Predictive Maintenance and Quality uses data from multiple sources to give
you the information that you need to make informed operational, maintenance,
repair, or component replacement decisions.

IBM Predictive Maintenance and Quality provides you with operational
intelligence data, which enables you to:

* Understand, monitor, predict, and control product and process variability
¢ Perform in-depth root cause failure analysis
¢ Identify incorrect operating practices

* Enhance equipment and process diagnostics capabilities

It also provides you with asset performance management capabilities that enable
you to:

* Have forward visibility into equipment and process performance
* Increase asset uptime

* Identify safety issues

* Identify improper maintenance procedures

¢ Optimize maintenance intervals and procedures.
Audience

This document is intended to help users install Predictive Maintenance and
Quality.

Finding information
To find IBM Predictive Maintenance and Quality product documentation on the

web, go to the [[BM Predictive Maintenance and Quality information center]
(http:/ /pic.dhe.ibm.com/infocenter/pmq/v1rOm0/index.jsp).

Accessibility features

Accessibility features help users who have a physical disability, such as restricted
mobility or limited vision, to use information technology products. Some of the
components included in the IBM Predictive Maintenance and Quality solution have
accessibility features.

IBM Predictive Maintenance and Quality HTML documentation has accessibility
features. PDF documents are supplemental and, as such, include no added
accessibility features.

Forward-looking statements

This documentation describes the current functionality of the product. References
to items that are not currently available may be included. No implication of any
future availability should be inferred. Any such references are not a commitment,
promise, or legal obligation to deliver any material, code, or functionality. The
development, release, and timing of features or functionality remain at the sole
discretion of IBM.
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Chapter 1. IBM Predictive Maintenance and Quality

With IBM Predictive Maintenance and Quality, you can monitor, analyze, and
report on information that is gathered from devices. In addition, recommendations
for actions can be generated by IBM Predictive Maintenance and Quality.

IBM Predictive Maintenance and Quality is an integrated solution that you can use
to perform the following tasks:

* Predict the failure of an instrumented asset so that you can prevent costly
unexpected downtime.

* Quickly mine maintenance logs to determine the most effective repair
procedures and maintenance cycles.

* Identify the root cause of asset failure faster so that you can take corrective
actions.

Instrumented assets generate data such as device 1D, timestamp, temperature, and
status code. This data can be collected and used in models that predict when an
asset is likely to fail.

Examples of instrumented assets are manufacturing equipment, mining equipment,
drilling equipment, farming equipment, security equipment, cars, trucks, trains,
helicopters, engines, cranes, oil platforms, and wind turbines.

For example, an oil refinery is a system that combines thousands of interlocking
pieces. It is critical that such a system is able to work safely and efficiently. You
can use IBM Predictive Maintenance and Quality to monitor and track the lifecycle
of each piece of the refinery, such as each pipe, pump, compressor, valve, furnace,
turbine, tank, heat exchange unit, and boiler. Reports give you the information to
ensure that you have the right parts available and can schedule repairs during
downtimes.

Predictive maintenance

In predictive maintenance, you look for patterns in the usage and environmental
information for equipment that correlate with failures that take place. This
information is used to create predictive models to score incoming new data. You
can predict the likelihood of failure. Scores are generated from this information
that give you an indication of the health of the piece of equipment. In addition,
key performance indicators (KPIs) are collected, which are used for reporting. KPIs
help you to identify assets that do not conform to normal patterns of behavior. You
can define rules to generate recommendations when a piece of equipment is
identified as having a high probability of failure. Recommendations can be fed into
other systems so that people are alerted to them automatically.

Predictive quality in manufacturing

Past operations data, environmental data, and historical defect data can be used to
identify the causes of elevated defect rates. This information is used in predictive
models, so that when incoming data is fed into the models, you can predict the
likely defect rates. The predicted values are then used for analysis and reporting
and to drive recommendations such as modification to inspection patterns, or
recalibration of machinery. Scoring can be done on a near real-time basis.

© Copyright IBM Corp. 2013 1



Solution architecture

The IBM Predictive Maintenance and Quality solution is divided into nodes, where
each node provides a specific function for the solution. Each node must be
installed on a separate computer or on a separate virtual machine image from
other nodes.

For a complete list of products included with Predictive Maintenance and Quality,
see |Appendix B, “Products installed with IBM Predictive Maintenance andl
Quality,” on page 65.]

The following diagram shows the nodes.

Predictive Analytics node:
IBM WebSphere Application Server
SPSS products

Business Intelligence (BI) node:
IBM WebSphere Application Server
IBM HTTP Server

IBM Cognos Business Intelligence

A

Enterprise Service Bus (ESB) Node:
IBM WebSphere Message Queue
IBM WebSphere Message Broker

Master Data Management (MDM) Node:
IBM WebSphere Application Server
InfoSphere Master Data Management

'\

Data Node:
IBM DB2 database server

oy o) T

Figure 1. Predictive Maintenance and Quality nodes

Predictive Analytics node
The Analytics node in provides predictive scores and offers recommendations.

This node has the following software installed:

IBM WebSphere® Network Deployment

IBM SPSS® Collaboration and Deployment Services

IBM SPSS Modeler Server

IBM SPSS Data Access Pack

IBM SPSS Text Analytics Server

IBM SPSS Modeler Collaboration and Deployment Services Adapter
IBM SPSS Decision Management

IBM SPSS Statistics Server

IBM SPSS Statistics Collaboration and Deployment Services Adapter
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* IBM DB2” Client
Business Intelligence (Bl) node
The BI node provides dashboards and reports.

This node has the following software installed:
* IBM WebSphere Network Deployment

* IBM HTTP Server

« IBM Cognos® Business Intelligence

+ IBM DB2 Client

Enterprise Service Bus (ESB) node

The ESB node server processes events, updates the content for IBM Cognos
Business Intelligence, and triggers predictive scoring and decision management. It
also loads master data into the solution.

This node has the following software installed:

* IBM WebSphere Message Queue

* IBM WebSphere Message Broker

* IBM WebSphere Message Broker Explorer

* IBM WebSphere Message Broker ODBC Database Extender

Master Data Management (MDM) node

The MDM node manages the master data for the solution. The master data
includes the set of devices that supply events to the solution and their locations. It
also includes metadata that is used to determine how events are processed by the
solution.

This node has the following software installed:

* IBM WebSphere Network Deployment

+ IBM InfoSphere® Master Data Management Collaboration Edition
+ IBM DB2 Client

Data node

The Data node provides the database server that contains the databases that are
used by other products in the solution. The database acts as an event store and
holds calculated key performance indicators (KPIs) and profiles. It also contains

supporting master data for the solution.

This node has the following software installed:
* IBM DB2 Enterprise Server Edition

Chapter 1. IBM Predictive Maintenance and Quality 3
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Chapter 2. Installation planning and preparation

Before you install IBM Predictive Maintenance and Quality, ensure that the
computers that you use meet the minimum requirements for operating systems,
prerequisite software, processing, and disk space.

You must also install additional prerequisite software on some computers,
including the Business Intelligence (BI) node, the Master Data Management (MDM)
node, and the Enterprise Service Bus (ESB) node computers.

Important: The computers or virtual machines that you use for Predictive
Maintenance and Quality nodes must not have any of the included software
already installed.

Critical installation and configuration issues

To review a list of critical installation and configuration issues for IBM Predictive
Maintenance and Quality version 1.0 as of the date of release, see the document
titled [Critical installation and configuration issues for IBM Predictive Maintenancel
land Quality version 1.0| (http:/ /www.ibm.com/support/
docview.wss?uid=swg21637185).

Supported operating systems and hardware requirements

Review the minimum hardware and operating system requirements before you
install IBM Predictive Maintenance and Quality. The requirements apply for all
computers or virtual machines that you use for the installation.

Server computers

The IBM Predictive Maintenance and Quality server components must be installed
on computers that are running the 64-bit Red Hat Enterprise Linux Server Edition
version 6.3 (x86_64) operating system.

You must have the Legacy UNIX compatibility package installed. The package is
selected when the operating system is set up. The components of this package
must be installed on each computer or virtual machine image on which you install
a Predictive Maintenance and Quality node.

Hardware requirements

At a minimum, each computer or virtual machine that is hosting a
Predictive Maintenance and Quality server component, or node, must have
the following hardware requirements:

* 4 processors
* 8 GB of RAM
* 500 GB of hard disk space

Each node must be installed on a separate computer or on a separate
virtual machine image.

User requirements

© Copyright IBM Corp. 2013 5
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You must have root access to all of the computers on which you install a
Predictive Maintenance and Quality node. Each computer on which you
install a node must have remote root log in enabled.

You must log in to the computer where you run the installer as root.

Client computers

The Predictive Maintenance and Quality client components must be installed on
computers that are running Microsoft Windows 7 64-bit operating systems.

Ensuring that the required operating system packages are

installed

Specific operating system packages must be installed on each computer or virtual
machine where you install an IBM Predictive Maintenance and Quality node.

Ensure that the following packages are installed:

libXext-1.1-3.e16.7686.rpm
1ibXft-2.1.13-4.1.e16.1686.rpm
1ibXi-1.3-3.e16.1686.rpm
1ibXp-1.0.0-15.1.e16.1686.rpm
1ibXpm-3.5.8-2.e16.1686.rpm
libXrender-0.9.5-1.e16.7686.rpm
1ibXtst-1.0.99.2-3.e16.1686.rpm
compat-1ibstdc++-33-3.2.3-69.e16.1686.rpm
compat-1ibstdc++-296-2.96-144.e16.1686.rpm
expat-2.0.1-11.e16_2.1686.rpm
fontconfig-2.8.0-3.e16.1686.rpm
freetype-2.3.11-6.e16_2.9.1686.rpm
libstdc++-4.4.6-4.e16.1686.rpm
1ibX11-1.3-2.e16.1686.rpm
1ibXau-1.0.5-1.e16.1686.rpm
1ibxcb-1.5-1.e16.1686.rpm
1ibICE-1.0.6-1.e16.1686.rpm
libuuid-2.17.2-12.7.e16.1686.rpm
1ibSM-1.1.0-7.1.e16.1686.rpm
1ibXt-1.0.7-1.e16.71686.rpm
1ibXmu-1.0.5-1.e16.1686.rpm
1ibjpeg-6b-46.e16.1686.rpm
1ibpng-1.2.49-1.e16_2.1686.rpm
z1i1b-1.2.3-27.e16.1686.rpm
glibc-2.12-1.80.e16.1686.rpm
openmotif-2.3.3-4.e16.1686.rpm

Procedure

1.

Log in as root.

2. Type the following command to verify that an operating system package is

installed:

IBM Predictive Maintenance and Quality Version 1.0.0.1: Installation Guide



rpm -qi full package name
For example, to verify that 1ibXext-1.1-3.e16.1686 is installed, type rpm -qi
TibXext-1.1-3.e16.1686.

3. Install any package that is not already installed.

You must download any missing package, and then install the downloaded
package by typing the following command:

rpm -ihv full_package_name.rpm

For example, to install 1ibXext-1.1-3.e16.1686, type rpm -ihv
libXext-1.1-3.e16.1686.rpm.

4. Repeat these steps on each computer on which you install a Predictive
Maintenance and Quality node.

Verifying that the Legacy UNIX compatibility package is
installed

Legacy UNIX compatibility must be installed on each computer or virtual machine
where you install an IBM Predictive Maintenance and Quality node.

You must verify that the following packages are installed:
* authd-1.4.3-30.e16.x86_64.rpm

e cups-1pd-1.4.2-48.e16.x86_64.rpm

e dump-0.4-0.6.b42.e16.x86_64.rpm

e finger-0.17-39.e16.x86_64.rpm

e finger-server-0.17-39.e16.x86_64.rpm
e krb5-appl-servers-1.0.1-7.e16_2.1.x86_64.rpm
* ksh-20100621-16.e16.x86_64.rpm

* mksh-39-7.e16.x86_64.rpm

e ncompress-4.2.4-54.e16_2.1.x86_64.rpm
* rsh-0.17-60.e16.x86_64.rpm

* rsh-server-0.17-60.e16.x86_64.rpm

e rusers-0.17-61.e16.x86_64.rpm

e rusers-server-0.17-61.e16.x86_64.rpm
* rwho-0.17-34.e16.x86_64.rpm

e talk-0.17-34.e16.x86_64.rpm

* talk-server-0.17-34.e16.x86_64.rpm

* tcp_wrappers-7.6-57.e16.x86_64.rpm

e telnet-0.17-47.e16.x86_64.rpm

e telnet-server-0.17-47.e16.x86_64.rpm
* tftp-0.49-7.e16.x86_64.rpm

e xinetd-2.3.14-34.e16.x86_64.rpm

Procedure
1. Log in as root.

2. Type the following command to verify that an operating system package is
installed:

rpm -qi full package _name

For example, to verify that authd-1.4.3-30.e16.x86_64 is installed, type rpm
-qi authd-1.4.3-30.e16.x86_64.
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3. Install any package that is not already installed.

You must download any missing package, and then install the downloaded
package by typing the following command:

rpm -ihv full package _name.rpm

For example, to install authd-1.4.3-30.e16.x86_64, type rpm -ihv
authd-1.4.3-30.e16.x86_64.rpm.

4. Repeat these steps on each computer on which you install a Predictive
Maintenance and Quality node.

Installing prerequisite operating system packages on the Bl
node computer

Specific operating system packages must be installed on the Business Intelligence
(BI) node computer or virtual machine before you install IBM Predictive
Maintenance and Quality.

The following packages must be installed:
e Tibselinux-2.0.94-5.3.e16.1686.rpm
e cracklib-2.8.16-4.e16.1686.rpm

e db4-4.7.25-17.e16.1686.rpm

* audit-1ibs-2.2-2.e16.1686.rpm

* pam-1.1.1-13.e16.1686.rpm

The following packages must be installed by using YUM:
e apr-util

* libexpat.so0.0

* libXm.so.4

* compat-expatl

Procedure
1. Log in to the BI node computer as root.
2. Install the RPM packages.

a. Type the following command to verify that an operating system package is
installed:

rpm -qi full package name

For example, to verify that Tibselinux-2.0.94-5.3.e16.1686 is installed,
type rpm -qi Tibselinux-2.0.94-5.3.e16.1686.

b. Install any package that is not already installed.

You must download any missing package, and then install the downloaded
package by typing the following command:

rpm -ihv full_package_name.rpm

For example, to install 1ibselinux-2.0.94-5.3.e16.1686, type rpm -ihv
libselinux-2.0.94-5.3.e16.1686.rpm.

Important: To install pam-1.1.1-13.e16.1686.rpm, use the following
command: rpm --force -ivh pam-1.1.1-13.e16.1686.rpm.

3. Install the packages by using YUM.
a. Type the following command:

yum -y install apr-util libexpat.so.0 1ibXm.so.4 compat-expatl

8 IBM Predictive Maintenance and Quality Version 1.0.0.1: Installation Guide



Installing Java on the Predictive Analytics node computer

You must install a Java" Runtime Environment (JRE) on the computer you use as
the IBM Predictive Maintenance and Quality Analytics node.

You must install Java version 1.5 or later on the Analytics node computer.

Installation of Perl on the MDM node computer

You must install a version of Perl on the Master Data Management (MDM) node
computer for IBM Predictive Maintenance and Quality.

In the Deployment Wizard, you are prompted for a location on the MDM node
computer where you installed Perl.

For more information about installing Perl for IBM InfoSphere Master Data
Management, see the |MDM documentationkpic.dhe.ibm.com/ infocenter/mdm/
v10rl/index.jsp?topic=%2Fcom.ibm.pim.ins.doc%2Fpim_tsk_installingperl.html).

Note: For IBM Predictive Maintenance and Quality, the minimum version of Perl
is 5.10.

Installing IBM Data Server Driver on the ESB node computer

Before you can deploy IBM Predictive Maintenance and Quality, you must install
the IBM Data Server Driver for ODBC and CLI on the Enterprise Service Bus (ESB)
node computer.

Procedure

1. Go to the [[BM driver and client download page| (www.ibm.com/support/
docview.wss?uid=swg21385217).

2. Click the link for IBM Data Server Driver for ODBC and CLI (CLI Driver).
3. If prompted, log in with your IBM account.

4. Select IBM Data Server Driver for ODBC and CLI (Linux AMD64 and Intel
EM64T).

5. Click Continue, and download the driver.

6. Go to the directory where you downloaded the driver.

7. Type the following command to extract the files:
tar -zxf ibm_data_server_driver_for_odbc_c1i_linuxx64_v10.1.tar.gz
The files are extracted to the odbc_c1i/clidriver directory.

8. Copy the odbc_cli directory to the var directory to match the default location
in the server installer. For example, ensure the path is /var/odbc_c1i.

Disabling SELinux on all target computers

You must disable the Security-Enhanced Linux (SELinux) feature on all computers
where you install an IBM Predictive Maintenance and Quality node.

Procedure
1. Log in as root.
2. Type getenforce and press Enter. The resulting message should say Disabled.
3. If the status is not Disabled, do the following.
a. Go to the /etc/sysconfig directory.
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4.

b. Open the selinux file for editing.
c. Change the SELINUX value to disabled.
For example:
SELINUX=disabled
d. Save and close the file.
e. Restart the computer for the changes to take effect.

Repeat these steps on each computer on which you install a Predictive
Maintenance and Quality node.

Computer firewall settings required for the installation

The Deployment Wizard requires bidirectional communication with each IBM
Predictive Maintenance and Quality node when you install a server component or
server artifact component, and your firewall can interfere with this communication.
To unsure this communication, you must configure your firewall settings for the
installation.

Configuring your firewall settings for the Deployment Wizard

On each computer on which you will install an IBM Predictive Maintenance and
Quality node, you must open two ports to allow the bidirectional communication
that is required by the Deployment Wizard. After you open the ports in your
firewall, you can then enter these port values in the Deployment Wizard.

Procedure

1. Log in as root.

2. Back up your existing firewall settings by typing the following command:
/etc/init.d/iptables save

3. Add rules for the two ports that are required by the Deployment Wizard with
the following command:
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 35000 -j ACCEPT
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 30000 -j ACCEPT
Where port 35000 and 30000 are available port numbers on your computers.
You do not have to use these port numbers, but you must use available port
numbers.
If you do not use ports 35000 and 30000, ensure that you change only the port
number values in the commands.
Tip: Using the same port numbers for each target computer is recommended.

4. Type the following command to save your firewall settings:
/etc/init.d/iptables save

5. Type the following command to restart your firewall.
/etc/init.d/iptables restart

6. Verity that your changes have been applied with the following command:
iptables -L
The added port should appear in the list.

7. Repeat these steps on each computer on which you install a Predictive

Maintenance and Quality node, and on the computer from where you run the
installation if it is not one of the node computers.
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Configuring your firewall settings for the Data node
installation and configuration

Before you can install and configure the IBM Predictive Maintenance and Quality
Data node, you must ensure that the database server port number is open on the
Data node computer.

Procedure

1. Log in to the Data node computer as root.

2. Back up your existing firewall settings by typing the following command:
/etc/init.d/iptables save

3. Add rules for the port with the following command:
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport port_number -j ACCEPT

For example, to open 50000, type the following command
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 50000 -j ACCEPT

Note: If you are using a port number other than 50000 for your database
server, ensure you open the appropriate port number.

4. Type the following command to save your firewall settings:
/etc/init.d/iptables save

5. Type the following command to restart your firewall.
/etc/init.d/iptables restart

6. Verify that your changes have been applied with the following command:
iptables -L
The added ports should appear in the list.

Disabling your computer's firewall during the installation

If you choose to temporarily disable your computer's firewall during the
installation of IBM Predictive Maintenance and Quality, ensure that you enable the
firewall on each node after the installation is complete.

Important: If you disable your computer's firewall during the installation, you
must still ensure that the required ports are opened on each node computer when
you restart your firewall.

Procedure

1. Log in as the root user.

2. Go to the /etc/init.d directory.

3. Type the following command:
iptables stop

4. Repeat these steps on each computer on which you install a node and on the
server from which you are running the installation.

What to do next

After the installation is complete, on each node, go to the /etc/init.d directory,
and type iptables start to restart your firewall.

Chapter 2. Installation planning and preparation 11



Mounting the USB hard disk drive

The installation files for IBM Predictive Maintenance and Quality are provided on
a universal serial bus (USB) hard disk drive. You can run the installation from the
USB or you can copy the files to your computer before you start the installation.
Before you do either, you must mount the USB hard disk drive.

For more information about mounting USB hard disk drives, see the
ICustomer Portall (https:/ /access.redhat.com/home).

Verifying that your servers prerequisites are met

12

Scripts are provided to help you ensure that the computers on which you install an
IBM Predictive Maintenance and Quality node meet the minimum requirements.

The following scripts are provided:

CheckPkg.sh
Verifies that the required rpm packages are installed on the computer. The
rpm names are listed in the packages.1st file.

CheckDB2.sh
Verifies the version, installation location, instance name, and status of an
existing IBM DB2 server.

CheckPaf.sh
Verifies the operating system, disk space, memory, and number of
processors for computer.

checkport.sh
Verifies that a port is open on the computer firewall. For example, on the
Data node computer, type ./checkport.sh 50000 to ensure that port 50000
is open on that computer.

CheckRemotePort.sh
Verifies that a port is open on a remote computer's firewall. For example,
to verify that the database server port number is open on the Data node
computer, type ./CheckRemotePort.sh data_node_name 50000 to ensure that
port 50000 is open on that computer. data_node_name can be the fully
qualified domain name or IP address of the Data node computer.

CheckUser.sh
Verifies that the current user is root.

CheckWAS.sh
Tests if WebSphere Application Server is installed on a node computer. If
installed, the version, build level and date, and installation location are
displayed.

Procedure

1. In a terminal window, go to the USB hard disk drive that you mounted or to
the directory where you copied the installation files.

2. In a terminal window, go to the USB hard disk drive that you mounted or to
the directory where you copied the installation files.

3. Go to the Prerequisite Checker directory.

4. Copy the scripts to each computer on which you want to verify that the
prerequisites are met.

5. Run the scripts as required.
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Chapter 3. Installation of the server components

The installation program installs the required software on each computer that you
identify as an IBM Predictive Maintenance and Quality node. The installation
program can be run from one of the computers that will be a node, or it can be
run from another computer.

Installation process

With the IBM Predictive Maintenance and Quality installation program, you can
select the individual computers on which each solution node is to be installed and
enter configuration information for each software component.

Staging server: Analytics Node
All installation files are located
on this computer

- =

[ Deployment Wizard ]

Installs and configures Bl Node

software components

on each node \

ESB Node

MDM Node

n- / ////- / ////- / V/
i

' Data Node:
Install IBM DB2 or

use an existing
% IBM DB2 server

Figure 2. Predictive Maintenance and Quality installation process

In the diagram, the staging server represents the computer from which you run the
installation. In your installation, the staging server can also be used as a node
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computer. The staging server must also be using the same operating system as the
other computers on which you install a node. It must also have the same
prerequisites.

Starting the installer for the server components

Use the Launchpad to start the IBM Predictive Maintenance and Quality server
installer.

Before you begin

Ensure that you are logged in as root.

You must have a Firefox, version 10 or earlier, or SeaMonkey, version 2.9 or earlier,
web browser installed and set as your default web browser on the computer from
where you run the installation.

Procedure

1.

In a terminal window, go to the USB hard disk drive that you mounted or to
the directory where you copied the installation files.

Go to the ServerInstaller/diskl directory.

Type the following command to change the permissions for the installation
files:

chmod -R 755 *

Enter the following command:

./launchpad.sh

Review the information in the Launchpad panels.

To start the Deployment Wizard, click Install Server > Predictive Maintenance
and Quality Server Installer.

Setting port numbers for the Deployment Wizard to use

14

If you opened ports for the installation of IBM Predictive Maintenance and Quality
components, you must set those port numbers in the Deployment Wizard.

Procedure

1.

In the Deployment Wizard, click Edit > Preferences.
The Deployment Preferences window appears.
Enter 30000 in the Data Port Number box.

Important: Ensure that you enter the port number that you opened if you
selected a port other than 30000.

Enter 35000 in the Communication Port Number box.

Important: Ensure that you enter the port number that you opened if you
selected a port other than 35000.

If you are using the computer on which you are running the installation as a
node, do the following steps:

a. Click Target Computer Settings.
b. Select localhost in the Target Computer field.

c. Enter the communication port number that you set in the Communication
Port field. For example, enter 35000.
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Note: The RMI Registry Port is unavailable if you are using localhost as a
node.

Installing or selecting a database instance

IBM Predictive Maintenance and Quality requires a database instance. You can
install IBM DB2 from the Deployment Wizard or use an existing IBM DB2
instance.

If you are using an existing IBM DB2 instance, it must be IBM DB2 Enterprise
Server Edition 9.7 with IBM DB2 9.7 Fix Pack 7.

Procedure
1. Select one of the following options:
* Install IBM DB2 Enterprise Server Edition
* Use existing IBM DB2 Enterprise Server Edition

If you select this option, IBM DB2 Enterprise Server Edition must already be
installed and running on the Data node computer.

2. Click Next.

Specifying the target computers to install the server components

You must specify a different target computer for each IBM Predictive Maintenance
and Quality node. A node can be installed on a computer or virtual machine, but
each node must be installed on a separate computer or virtual machine.

Before you begin
You must have root access on each computer on which you install a node.

You might have to change a setting in a configuration file on your target computer
to allow the Deployment Wizard to access the computer as root. Use the
following steps if you receive a message that says the connection to the target
computer was refused:

1. On the target computer, go to the /etc/ssh directory and open sshd_config for
editing.
2. Change the PermitRootLogin property to yes.

3. Save the file. You may have to restart the server for the change to take effect.

Procedure

1. On the Specify Target Computers pages of the Deployment Wizard, enter the
name or IP address of the computer on which you install a node in the Target
Computer box.

The Deployment Wizard prompts you for each node computer.

If you are installing a node on the computer where you are running the
Deployment Wizard, you can enter localhost.

2. Click Add.

a. When you enter a computer other than localhost, in the Target Computer
Credentials box, enter the User ID and Password for the root user.

Important: Ensure that you enter the credentials for the root user on the
target computer.
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b. Click Test Login.
c. Click Add.

The computer that you entered appears in the Selected target computers
box.
3. Do the following steps if you opened ports for the installation.

a. Click Edit > Preferences.

b. Click Target Computer Settings.

C. Select the computer name or IP address in the Target Computer field.

d. Enter the communication port number that you set in the Communication
Port field. For example, enter 35000.

e. Enter the Data Port Number that you set in the RMI Registry Port field.
For example, enter 30000.

Note: If you are using localhost as a node in the installation, the RMI
Registry Port is unavailable.

4. In the Selected target computers box, select the target computer, and click Test
Connections.

Important: Test Connections tests the connection, tests the credentials, and
locates or enables a deployment agent on the target computer. You must have
an active deployment agent on each target computer.

If you receive an error message after you click Test Connections, you might
have to change some settings on your computers.

 Edit your iptable settings or temporarily disable your firewall. For more
information, see [“Computer firewall settings required for the installation” on|

¢ Compare and correct your domain name system (DNS) settings for each
computer. For example, type sudo system-config-network. Select DNS
configuration, and ensure that your host name domain and DNS search path
settings are correct.

* Ensure that the /etc/hosts file has the correct entries. For an example, see
[“Test Connections validation errors” on page 67|

5. Click Next.
6. Repeat the steps for each computer on which you install a node.

Configuring parameters for the server components installation

The Deployment Wizard displays some default values for each component of IBM
Predictive Maintenance and Quality. You can accept the default values or change
them to suit your environment.

If you are prompted for users, the Deployment Wizard creates the users on the
appropriate target node computer, if they do not exist. For example, IBM DB2
requires a DB2 administrator user, an instance owner user, and a fenced user. Each
of these users is created on the Data node computer.

Procedure

Use the following tables to verify or enter values in each field on each panel of the
Deployment Wizard:

* Clicking Browse browses the target computer's file system. It does not browse
the local computer from where you are running the Deployment Wizard.
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* For some values, such as passwords, default values are not provided. Ensure
that you enter all values on each panel of the Deployment Wizard.

¢ On the Configure IBM DB2 Enterprise Edition page, enter a name for each
database that is to be created by the Deployment Wizard.

Important: Ensure you use a separate database for each product.

Important: You cannot use the same user for the IBM DB2 administrative user

and the instance owner. They must be different users.

Table 1. IBM DB2 configuration parameters for a new database server installation

Field

Default or example value

Description

DB2 Server Installation
Directory

/opt/ibm/db2/V9.7

The location where IBM DB2
is to be installed on the Data
node computer.

DB2 Database Port Number |50000 The port number that is used
by IBM DB2.
DB2 Server Administrative |dasusrl The user ID that runs the

User Name

administration server.

DB2 Server Administrative
Password

There is no default value for
this field.

The password for the user ID
that runs the administration
server.

The password cannot contain
more than 8 characters.

DB2 Server Administrative |/home/dasusrl The home directory for the

Home Directory user ID that runs the
administration server. This
directory is on the Data node
computer's file system.

DB2 Instance Owner User db2instl The user ID that controls the

Name

DB2 processes and owns the
directories that are used by
the database instance.

DB2 Instance Owner
Password

There is no default value for
this field.

The password for the DB2
instance owner user.

The password cannot contain
more than 8 characters.

DB2 Instance Owner Home | /home/db2instl The home directory for the

Directory DB2 instance owner user.
This directory is on the Data
node computer's file system.

DB2 Fenced User Name db2fencl The user ID that can run

user-defined functions and
store procedures.

DB2 Fenced Password

There is no default value for
this field.

The password for the DB2
instance owner user.

The password cannot contain
more than 8 characters.

DB2 Fenced User Home
Directory

/home/db2fencl

The home directory for the
DB2 instance owner user.
This directory is on the Data
node computer's file system.
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Table 2. IBM DB2 configuration parameters for an existing database server

Field

Default or example value

Description

DB2 Installation Location

/opt/ibm/db2/V9.7

The location where IBM DB2
is installed on the Data node
computer.

DB2 Instance Name

db2instl

The name of the instance in
which your databases are
created.

DB2 Instance Password

There is no default value for
this field.

The password for the DB2
instance owner user.

DB2 Port Number

50000

The port number that is used
by IBM DB2.

Table 3. IBM DB2 configuration parameters: Database names.
Important: The database names cannot exceed 8 characters.

Field

Default or example value

Description

SPSS Database Name

SPSSDB

The SPSS database that is
used by the components that
are installed on the
Predictive Analytics node
computer.

Cognos Database Name €0G102CS The IBM Cognos content
store database.
MDM Database Name MDMDB The Master Data

Management (MDM) node
database.

Table 4. IBM DB2 client parameters.
Note: The values apply to all nodes where the IBM DB2 client is installed.

Field

Default or example value

Description

DB2 Client Installation
Directory

/opt/ibm/db2/V9.7

The location where the IBM
DB2 client is to be installed.
This directory is on the
MDM node, Business
Intelligence (BI) node, and
Analytics node computer's
file system.

DB2 Client Instance User
Name

db2instl

The user ID for the DB2
client.

DB2 Client Instance
Password

There is no default value for
this field.

The password for the DB2
client instance owner user.

DB2 Client Instance Home
Directory

/home/db2inst1

The home directory for the
DB2 client instance owner
user on each node.
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Table 5. WebSphere installation parameters

Field

Default or example value

Description

WebSphere Installation
Directory

/opt/1BM/WebSphere/
AppServer

The location where the
WebSphere Application
Server is to be installed. The
location is the same for each
node where WebSphere is
installed.

Table 6. HTTP Server installation parameters

Field

Default or example value

Description

HTTP Server Installation /opt/IBM/HTTPServer The location where IBM

Directory HTTP Server is to be
installed. This directory is on
the BI node computer's file
system.

HTTP Port Number 80 The port number that is used

by HTTP Server.

Table 7. IBM Cognos Bl installation parameters

Field

Default or example value

Description

Cognos BI Installation
Location

/opt/ibm/cognos/c10_64

The location where IBM
Cognos Bl is to be installed.
This directory is on the BI
node computer's file system.

Table 8. WebSphere profile for IBM Cognos Bl parameters.

Note: The settings in this table are applied to the WebSphere installation on the Bl node.

Field Default or example value Description
WebSphere Profile Location | /opt/IBM/WebSphere/ The location where the
AppServer/profiles WebSphere profile is to be
created. This directory is on
the BI node computer's file
system.
WebSphere Profile Name COGNOSProfile The name of the WebSphere

profile that is used for IBM
Cognos BI.

WebSphere Host Name

This value is automatically
entered.

The name or IP address of
the BI node computer.

WebSphere Profile template
location

/opt/1BM/WebSphere/
AppServer/
profileTemplates/default

The location where the
WebSphere profile templates
are located.

Table 9. IBM Cognos Bl Serve

r parameters

Field

Default or example value

Description

Database Host Name

This value is automatically
entered.

The name or IP address of
the Data node computer.

WebSphere Host Name

This value is automatically

entered.

The name or IP address of
the BI node.
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Table 9. IBM Cognos Bl Server parameters (continued)

Field Default or example value

Description

Cognos Dispatcher 9080
Application Server Port

The HTTP transport port
number for the WebSphere
Application Server where
IBM Cognos is running.

Database Server Host Name | This value is automatically
entered.

The name or IP address of
the Data node.

Table 10. WebSphere Message Broker installation parameters

Field Default or example value

Description

WebSphere Message Broker |/opt/ibm/mqsi/8.0.0.1
Installation Location

The location where
WebSphere Message Broker
is to be installed. This
directory is on the Enterprise
Service Bus (ESB) node
computer's file system.

WMB ODBC Database /opt/ibm/1E02/2.0.0
Extender Install Location

The location where
WebSphere Message Broker
ODBC Database Extender is
to be installed. This directory
is on the Enterprise Service
Bus (ESB) node computer's
file system.

WebSphere Message Broker |/opt/IBM/MBExplorer
Explorer Installation
Directory

The location where
WebSphere Message Broker
Explorer is to be installed.
This directory is on the
Enterprise Service Bus (ESB)
node computer's file system.

Table 11. WebSphere Message Broker and Queue installation

parameters

Field Default or example value

Description

ESB Deployment Location | /var/PMQ

The location where
Predictive Maintenance and
Quality files can be placed.

Location of the IBM Data /var/odbc_c1i
Server Driver for ODBC

The location where you
downloaded the IDM Data

and CLI Server Driver.
This directory is on the ESB
node computer's file system.
Broker Name pmgbroker The broker to be created.
Queue Manager Name pmgmanager The Queue Manager name to
be created.
Execution Group pmggroup The name of a group of

message flows that are
assigned to a broker

Specify Database Node IP | This value is automatically
Address entered.

The name of IP address of
the Data node computer.
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Table 12. WebSphere Message Broker installation parameters

Field

Default or example value

Description

MDM Collaboration Server
Installation Directory

/opt/IBM/MDMPIM

The location where Master
Data Management
Collaboration Server is to be
installed.

This directory is on the
MDM node computer's file
system.

Table 13. InfoSphere Master Data Management parameters

Field Default or example value Description
WebSphere Profile Location |/opt/IBM/WebSphere/ The location where the
AppServer/profiles WebSphere profile is to be
created. This directory is on
the MDM node computer's
file system.
WebSphere Profile Name MDMProfile The name of the WebSphere

profile that is used for
InfoSphere Master Data
Management.

WebSphere Host Name

This value is automatically
entered.

The name or IP address of
the MDM node computer.

Default WebSphere
Template Path

/opt/1BM/WebSphere/
AppServer/
profileTemplates/default

The location where the
WebSphere profile templates
are located.

MDM DB2 Host Name

This value is automatically
entered.

The name or IP address of
the Data node computer.

Perl Installation Directory

/opt/ActivePerl-5.16

The location where you
installed Active Perl.

This location on the MDM
node computer.

Table 14. IBM SPSS Collaboration and Deployment Server parameters

Field

Default or example value

Description

SPSS Collaboration and
Deployment Services
Installation Directory

/opt/IBM/SPSS/Deployment/
5.0/Server

The location where IBM SPSS
Collaboration and
Deployment Services is to be
installed. This location is on
the Analytics node
computer's file system.

WebSphere Profile Location | /opt/IBM/WebSphere/ The location where the
AppServer/profiles WebSphere profile is to be
created. This directory is on
the Analytics node
computer's file system.
WebSphere Profile Default | /opt/IBM/WebSphere/ The location where the
Template Location AppServer/ WebSphere profile templates

profileTemplates/default

are located. This directory is
on the Analytics node
computer's file system.
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Table 14. IBM SPSS Collaboration and Deployment Server parameters (continued)

Field

Default or example value

Description

WebSphere Profile Name

SPSSProfile

The name of the WebSphere
profile that is used for the
SPSS products.

WebSphere Host Name

This value is automatically
entered.

The name or IP address of
the Analytics node computer.

SPSS DB2 Database Host
Name

This value is automatically
entered.

The name or IP address of
the Data node computer.

Modeler Server Installation
Directory

/usr/IBM/SPSS/
ModelerServer/15.0

The directory where the IBM
SPSS Modeler Server is to be
installed. This directory is on
the Analytics node computer.

SPSS Collaboration and
Deployment Services
Enterprise Viewer
Installation Directory

/opt/IBM/SPSS/Deployment/
5.0/EnterpriseViewDriver

The directory where the IBM
SPSS Collaboration and
Deployment Services
Enterprise View Driver is to
be installed. This directory is
on the Analytics node
computer.

SPSS Collaboration and
Deployment Services
Python Installation
Directory

/opt/IBM/SPSS/Deployment/
5.0/PythonEssentials

The directory where the IBM
SPSS Collaboration and
Deployment Services Python
Scripting Essentials is to be
installed. This directory is on
the Analytics node computer.

Directory

StatisticsServer2l

SPSS Data Access Pack /root/SDAP61 The directory where the IBM

Installation Directory SPSS Data Access Pack is to
be installed. This directory is
on the Analytics node
computer.

SPSS Statistics Installation | /opt/IBM/SPSS/ The directory where the IBM

SPSS Statistics Server is to be
installed. This directory is on
the Analytics node computer.

Starting the installation

After you enter all of the required fields in the Deployment Wizard, you can start
the installation and configuration of the IBM Predictive Maintenance and Quality

components.

Procedure

On the Summary Panel of the Deployment Wizard, click Deploy all.

Note: If you choose to deploy the tasks individually, you must click Deploy task
for each task in the order that the tasks appear on the Summary panel.

Configure the server components and test the installation

22

After the installation of the IBM Predictive Maintenance and Quality server
components is complete, you must perform some additional configuration tasks
and then test the installation.
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Testing the database installation and configuration

You can test the database installation and configuration by logging in to the Data
node computer and listing the databases on the server. You can also list the
databases available on each node computer where the IBM DB2 client was
installed.

Procedure
1. Log on to the Data node computer.

a. Open a terminal window, and change to the database instance owner user.
For example, su - db2instl.

b. Enter the following command to list the databases on the computer:
db2 Tist database directory
The following databases are listed:
+ C0G102DB
* MDMDB
+ SPSSDB
2. Log on to the Business Intelligence (BI) node computer.

a. Open a terminal window, and change to the database client user. For
example, su - db2instl.

b. Enter the following command to list the databases on the computer:
db2 1ist database directory
C0G102DB is listed.
3. Log on to the Predictive Analytics node computer.

a. Open a terminal window, and change to the database client user. For
example, su - db2instl.

b. Enter the following command to list the databases on the computer:
db2 Tist database directory
SPSSDB is listed.
4. Log on to the Master Data Management (MDM) node computer.

a. Open a terminal window, and change to the database client user. For
example, su - db2instl.

b. Enter the following command to list the databases on the computer:
db2 Tist database directory
MDMDB is listed.

Configuring WebSphere Application Server for IBM Cognos Bl

To complete the installation of the IBM Predictive Maintenance and Quality server
components, you must configure properties in IBM WebSphere Application Server
for IBM Cognos Business Intelligence.

Procedure
1. Open a web browser.

2. In the address bar, type the address for the WebSphere Admin Console that
was installed on the Bl node computer.

The Admin console address is: http://bi_node_name:9060/ibm/console. Where
bi_node_name is the name or IP address for the BI node computer.

3. Expand Servers > Server Types > WebSphere application servers, and click
serverl.
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4. Under Server Infrastructure, expand Java and Process Management, and
click Process Definition.

5. Under Additional Properties, click Java Virtual Machine.
6. In the Initial Heap Size box, enter 512.
7. In the Maximum Heap Size box, enter 1024.
8. Click Apply, and then click Save.
9. Under Additional Properties, click Environment Variables.
10. Click New.
11. In the Name box, enter LD_LIBRARY_PATH.

12. In the Value box, enter the path the IBM Cognos BI bin64 directory. For
example, enter /opt/ibm/cognos/c10_64/bin64/.

Important: If you changed the default value in the Cognos BI Installation
Location field in the Deployment Wizard, ensure you use the path you
entered.

13. Click Apply, and then click Save.

Saving your IBM Cognos Configuration settings and starting
the services

You must save the configuration settings in IBM Cognos Configuration before you
can start the IBM Cognos application in WebSphere Application Server.

Procedure
1. Log in to the BI node computer as root.
2. Go to the /opt/ibm/cognos/c10_64/bin64 directory.
3. Type the following command:
./cogconfig.sh
IBM Cognos Configuration starts.
4. Click File > Save.
5. Close IBM Cognos Configuration.

Important: If you are prompted to start the Cognos Content Database service,
click No.

6. Log in to the Bl node computer as root using a terminal emulator, such as
PuTTY.

Note: Using a terminal emulator like PuTTY ensures that the proper profile is
loaded.

7. Go to the WebSphere Application Server Profile Location. For example, go to
the /opt/IBM/WebSphere/AppServer/profiles/COGNOSProfile/bin directory if
you used the default path in the Deployment Wizard.

8. Type ./stopServer.sh serverl to stop WebSphere Application Server.
9. Type ./startServer.sh serverl to start WebSphere Application Server.

Results
WebSphere Application Server is configured for IBM Cognos BI.

It may take several minutes for all of the IBM Cognos services to start for the first
time.
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Setting the password for the mqm user on the ESB node
computer

You must set the password for the mqm user on the Enterprise Service Bus (ESB)
node computer.

Procedure
1. Log in to the ESB node computer as root.
2. Type the following command:
passwd mgm
3. Enter mgm and the new password.

You do not have to use mgm. It is only a suggestion. If you do use mgm, you will
see a message saying that your password is too weak. But, you can ignore the
message.

Testing the installation of the server components

You can test the installation of the IBM Predictive Maintenance and Quality server
components by accessing some of the component portals.

For example, you can open the IBM Cognos Bl portal on the BI node. If the portal
opens, IBM Cognos Bl is installed and running. You can also access the SPSS
configuration tool on the Analytics node computer.

Procedure
1. Open a web browser.

2. In the address bar, type the address for the IBM Cognos Content Manager
status page.

The address is http://bi_node_name:9080/p2pd/servlet, where bi_node_name is
the name or IP address for the BI node computer.

The Content Manager status says Running.
3. In the address bar, type the address for the IBM Cognos BI portal.

The address is http://bi_node_name/ibmcognos/, where bi_node_name is the
name or IP address for the BI node computer.

Note: Ensure that you add the trailing / to the URL.
IBM Cognos Connection appears.
4. In the address bar, type the address for the SPSS administration console.

The address is http://analytics_node_name:9080/config, where
analytics_node_name is the name or IP address for the Analytics node
computer.

The SPSS administration console appears.

Computer firewall settings to run the server components

Each IBM Predictive Maintenance and Quality node computer requires certain
ports to be opened for the server components to operate in a multi-computer
solution, and you must configure your firewall settings for each specific node.

Configuring your firewall settings for all nodes

On each computer on which you install an IBM Predictive Maintenance and
Quality node, you must open specific ports.
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The following ports must be open:

* vnc-server

* x11

* 5901

> 5902

> 5903

* 6001

* 6002

* 6003

. 22

Procedure

1. Log in as root.

2. Back up your existing firewall settings by typing the following command:
/etc/init.d/iptables save

3. Add rules for the ports with the following command:
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport port_number -j ACCEPT
For example, to open vnc-server, type the following command
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport vnc-server -j ACCEPT

4. Type the following command to save your firewall settings:
/etc/init.d/iptables save

5. Type the following command to restart your firewall.
/etc/init.d/iptables restart

6. Verify that your changes have been applied with the following command:
iptables -L
The added port should appear in the list.

7. Repeat these steps on each computer on which you install a Predictive

Maintenance and Quality node.

Configuring your firewall settings for the Analytics node
computer

You must ensure that certain ports are open on the Predictive Analytics node
computer for IBM Predictive Maintenance and Quality.

The following ports must be open:

45088

58313

28052
tungsten-https
glrpc

corbaloc

59356

9043

9060
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Procedure

1.
2.

Log in to the Analytics node computer as root.

Back up your existing firewall settings by typing the following command:
/etc/init.d/iptables save

Add rules for the ports with the following command:

iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport port_number -j ACCEPT

For example, to open 45088, type the following command

iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 45088 -j ACCEPT
Repeat the previous step for each of the required port values.

Type the following command to save your firewall settings:
/etc/init.d/iptables save

Type the following command to restart your firewall.
/etc/init.d/iptables restart

Verify that your changes have been applied with the following command:
iptables -L

The added ports should appear in the list.

Configuring your firewall settings for the Bl nhode computer

You must ensure that certain ports are open on the Business Intelligence (BI) node
computer for IBM Predictive Maintenance and Quality.

The following ports must be open:

9362
vrace
9663
corbaloc
9043
glrpc
http
tungsten-https
9060
6001
6002
6003
5901
5902
5903

Procedure

1.
2.

Log in to the BI node computer as root.

Back up your existing firewall settings by typing the following command:
/etc/init.d/iptables save

Add rules for the ports with the following command:

iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport port_number -j ACCEPT

For example, to open 9362, type the following command
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iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 9362 -j ACCEPT

4. Repeat the previous step for each of the required port values.

5. Type the following command to save your firewall settings:
/etc/init.d/iptables save

6. Type the following command to restart your firewall.
/etc/init.d/iptables restart

7. Verify that your changes have been applied with the following command:
iptables -L
The added ports should appear in the list.

Configuring your firewall settings for the ESB node computer

You must ensure that certain ports are open on the Enterprise Service Bus (ESB)
node computer for IBM Predictive Maintenance and Quality.

The following ports must be open:
* boks

* boks_clntd

* boks_servm

* boks_servc

* ibm-mgseries

Procedure

1. Log in to the ESB node computer as root.

2. Back up your existing firewall settings by typing the following command:
/etc/init.d/iptables save

3. Add rules for the ports with the following command:
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport port_number -j ACCEPT

For example, to open boks, type the following command
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport boks -j ACCEPT
4. Repeat the previous step for each of the required port values.
5. Type the following command to save your firewall settings:
/etc/init.d/iptables save
6. Type the following command to restart your firewall.
/etc/init.d/iptables restart
7. Verity that your changes have been applied with the following command:
iptables -L
The added ports should appear in the list.

Configuring your firewall settings for the MDM node computer

You must ensure that certain ports are open on the Master Data Management
(MDM) node computer for IBM Predictive Maintenance and Quality.

The following ports must be open:
* 9060

* tungsten-https

+ 50498
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9634

9633

57537
49888
53343
41950
60573
43420
40187
netsteward
corbaloc
glrpc
44152
43830
39188

9043

7507

49298

8881
cddbp-alt
40752
50512
35086
bacula-dir
jetdirect
55052
32970
commplex-1ink
37253

9060

Procedure

1
2.

Log in to the MDM node computer as root.

Back up your existing firewall settings by typing the following command:
/etc/init.d/iptables save

Add rules for the ports with the following command:

iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport port_number -j ACCEPT

For example, to open 9060, type the following command

iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport 9060 -j ACCEPT
Repeat the previous step for each of the required port values.

Type the following command to save your firewall settings:
/etc/init.d/iptables save

Type the following command to restart your firewall.
/etc/init.d/iptables restart

Verify that your changes have been applied with the following command:
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iptables -L
The added ports should appear in the list.

Configuring your firewall settings for the Data node computer

You must ensure that certain ports are open on the Data node computer for IBM
Predictive Maintenance and Quality.

The following ports must be open:
* ibm-db2
* db2c_db2instl

Procedure

1. Log in to the Data node computer as root.

2. Back up your existing firewall settings by typing the following command:
/etc/init.d/iptables save

3. Add rules for the ports with the following command:
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport port_number -j ACCEPT
For example, to open ibm-db2, type the following command
iptables -I INPUT -m state --state NEW -m tcp -p tcp --dport ibm-db2 -j ACCEPT

4. Type the following command to save your firewall settings:
/etc/init.d/iptables save

5. Type the following command to restart your firewall.
/etc/init.d/iptables restart

6. Verify that your changes have been applied with the following command:

iptables -L
The added ports should appear in the list.
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Chapter 4. Fix pack updates for the server components

Fix pack updates are available for IBM Predictive Maintenance and Quality server
nodes.

You must install the fix pack updates for
1. [the Data node]

2. [the Business Intelligence (BI)|

the Enterprise Service Bus (ESB)

the Predictive Analytics node
the Master Data Management (MDM) node]

w

B

o

Apply fix pack updates to the Data node
You must stop the IBM DB2 services before you apply the fix pack updates.

IBM DB2 Server

For more information about IBM DB2 fix packs, see the [DB2 Version 9.7 Fix Pack §
Ifor Linux, UNIX, and Windows fix pack document| (http:/ /www.ibm.com/
support/docview.wss?uid=swg24034634).

For more information about installing IBM DB2 fix packs, see the |[BM DB

(pic.dhe.ibm.com/infocenter /db2luw /v9r7 /index.jsp?topic=/
com.ibm.db2.luw.gb.server.doc/doc/c0025016.html).

Apply fix pack updates to the Business Intelligence (Bl) node

You must apply fix pack updates to the IBM DB2 client, WebSphere Application
Server, IBM HTTP Server, and to IBM Cognos Business Intelligence on the
Predictive Maintenance and Quality Bl node computer.

IBM DB2 Client

For more information about IBM DB2 fix packs, see the [DB2 Version 9.7 Fix Pack §
ffor Linux, UNIX, and Windows fix pack document] (http:/ /www.ibm.com/
support/docview.wss?uid=swg24034634).

For more information about installing IBM DB2 Connect on Linux operating
systems, see the IIBM DB2 documentation| (pic.dhe.ibm.com/infocenter/db2luw/
vIr7 /index jsp?topic=%2Fcom.ibm.db2.luw.qb.dbconn.doc%2Fdoc
%2Ft0008459.html).

WebSphere Application Server

For more information about WebSphere Application Server fix packs, see the
8.0.0.7: WebSphere Application Server V8.0 Fix Pack 7 document]
(www.ibm.com/support/docview.wss?uid=swg24035457).

For more information about installing WebSphere Application Server fix packs, see
thdWebSphere documentation| (pic.dhe.ibm.com/infocenter/wasinfo/v8r0/
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index.jsp?topic=%2Fcom.ibm.websphere.installation.nd.doc%2Finfo%2Fae%2Fae
%2Ftins_upgrade.html).

IBM Cognos Business Intelligence
For more information about IBM Cognos Business Intelligence fix packs, see the

IBM Cognos Business Intelligence 10.2.1 Fix Pack 1 document| (www.ibm.com/
support/docview.wss?uid=swg24035542).

For more information about installing IBM Cognos Business Intelligence fix packs,
see the [[BM Cognos fix pack documentation| (www.ibm.com /software /analytics/
cognos/support/fixpacks.html).

Apply fix pack updates to the Enterprise Service Bus (ESB) node

You must install fix pack updates for WebSphere Message Queue on the ESB node
to apply the updates for IBM Predictive Maintenance and Quality.

WebSphere Message Queue
For more information about WebSphere Message Queue fix packs, see the

[WebSphere MQ V7.5 Fix Pack 7.5.0.2 document| (www.ibm.com/ support/
docview.wss?uid=swg24035286).

For more information about installing fix pack updates for WebSphere Message
Queue, see the [WebSphere Message Queue documentation| (pic.dhe.ibm.com/
infocenter/wmqv?7/v7r5/index.jsp?topic=%2Fcom.ibm.mq.mig.doc
%2Fq008000_.htm).

WebSphere Message Broker

For more information about WebSphere Message Broker fix packs, see the
[WebSphere Message Broker V8.0 - Fix Pack 8.0.0.3 document (www.ibm.com/
support/docview.wss?uid=swg24036309).

For more information about installing fix pack updates for WebSphere Message
Broker, see the WebSphere Message Broker documentation| (http://
pic.dhe.ibm.com/infocenter/wmbhelp /v8rOm0/index.jsp?topic=
%2Fcom.ibm.etools.mft.doc%2Fbx89999_.htm).

Apply fix pack updates to the Predictive Analytics node

32

You must apply fix pack updates to the IBM DB2 client, WebSphere Application
Server, and to IBM SPSS Collaboration and Deployment Services components on
the IBM Predictive Maintenance and Quality Analytics node computer.

IBM DB2 Client

For more information about IBM DB2 fix packs, see the [DB2 Version 9.7 Fix Pack §
ffor Linux, UNIX, and Windows fix pack document| (http://www.ibm.com/
support/docview.wss?uid=swg24034634).

For more information about installing IBM DB2 Connect on Linux operating
systems, see the IIBM DB2 documentation| (pic.dhe.ibm.com/infocenter/db2luw/
vIr7 /index.jsp?topic=%2Fcom.ibm.db2.luw.qb.dbconn.doc%2Fdoc
%2Ft0008459.html).
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WebSphere Application Server

For more information about WebSphere Application Server fix packs, see the
18.0.0.7: WebSphere Application Server V8.0 Fix Pack 7 document|
(www.ibm.com/support/docview.wss?uid=swg24035457).

For more information about installing WebSphere Application Server fix packs, see
thdWebSphere documentation| (pic.dhe.ibm.com/infocenter/wasinfo/v8r0/
index.jsp?topic=%2Fcom.ibm.websphere.installation.nd.doc%2Finfo%2Fae%?2Fae
%2Ftins_upgrade.html).

IBM SPSS products

For more information about installing IBM SPSS Collaboration and Deployment
Services fix packs, see the [SPSS Collaboration and Deployment Services 5.0 Fix|
IPack 2 upgrade document|(www.ibm.com/support/
docview.wss?uid=swg24034742).

For more information about installing SPSS Modeler fix packs, see the
[Modeler 15.0 Fix Pack 2 - Professional Components document]
(www.ibm.com/support/docview.wss?uid=swg24034741).

Apply fix pack updates to the Master Data Management (MDM) node

You must apply fix pack updates to the IBM DB2 client and WebSphere
Application Server components on the IBM Predictive Maintenance and Quality
MDM node computer.

IBM DB2 Client

For more information about IBM DB2 fix packs, see the [DB2 Version 9.7 Fix Pack §
ffor Linux, UNIX, and Windows fix pack document] (http://www.ibm.com/
support/docview.wss?uid=swg24034634).

For more information about installing IBM DB2 Connect on Linux operating
systems, see the IIBM DB2 documentation| (pic.dhe.ibm.com/infocenter/db2luw /
vIr7 /index jsp?topic=%2Fcom.ibm.db2.luw.qb.dbconn.doc%2Fdoc
%2Ft0008459.html).

WebSphere Application Server

For more information about WebSphere Application Server fix packs, see the
8.0.0.7: WebSphere Application Server V8.0 Fix Pack 7 document]
(www.ibm.com/support/docview.wss?uid=swg24035457).

For more information about installing WebSphere Application Server fix packs, see
tdeebSphere documentation| (pic.dhe.ibm.com/infocenter/wasinfo/v8r0/
index.jsp?topic=%2Fcom.ibm.websphere.installation.nd.doc%2Finfo%2Fae%?2Fae
%2Ftins_upgrade.html).
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Chapter 5. Installation of the server artifacts

The server artifacts include report content and workflows for IBM Predictive
Maintenance and Quality. The installation program will install artifacts on each
node computer.

Important: If you are installing Predictive Maintenance and Quality for the first
time, you do not have to install the server artifacts components that are included
in the original product source files. Instead, install the server artifacts that are
provided with the fix pack updates.

If you already have a Predictive Maintenance and Quality environment up and
running, use the server artifact installer that is provided with the fix pack to
update your existing Predictive Maintenance and Quality content.

Back up existing content for installing the fix pack updates to an
existing environment

If you are installing the fix pack updates to an IBM Predictive Maintenance and
Quality environment in which you already deployed the server artifacts, back up
the existing content before you install the server artifacts that are provided with
the fix pack.

If you are installing the server artifacts for the first time, you do not have to back
up the content.

You must back up content on the Enterprise Service Bus (ESB) node and the
Business Intelligence (BI) node computers.

For more information about backing up IBM WebSphere Message Broker content
on the ESB node computer, see the [WebSphere Message Broker documentation|
(pic.dhe.ibm.com/infocenter /wmbhelp /v8r0m0/index.jsp?topic=
%2Fcom.ibm.etools.mft.doc%2Fbh44660_.htm).

For more information about backing up IBM WebSphere Message Queue content
on the ESB node computer, see the WebSphere Message Queue documentation|
(pic.dhe.ibm.com/infocenter/wmqv?7/v7r5/index.jsp?topic=
%2Fcom.ibm.mgq.con.doc%2Fq018580_.htm).

For more information about backing up IBM Cognos content on the BI node
computer, see the [[BM Cognos documentation] (pic.dhe.ibm.com/infocenter/cbi/
v10r2m1/index.jsp?topic=%2Fcom.ibm.swg.ba.cognos.inst_cr_winux.10.2.1.doc
%2Ft_backupexistingcognosinformation.html).

Starting the installer for the server artifacts

Use the Launchpad to start the IBM Predictive Maintenance and Quality server
artifacts installer.

© Copyright IBM Corp. 2013 35


http://pic.dhe.ibm.com/infocenter/wmbhelp/v8r0m0/index.jsp?topic=%2Fcom.ibm.etools.mft.doc%2Fbh44660_.htm
http://pic.dhe.ibm.com/infocenter/wmqv7/v7r5/index.jsp?topic=%2Fcom.ibm.mq.con.doc%2Fq018580_.htm
http://pic.dhe.ibm.com/infocenter/cbi/v10r2m1/index.jsp?topic=%2Fcom.ibm.swg.ba.cognos.inst_cr_winux.10.2.1.doc%2Ft_backupexistingcognosinformation.html

Note: If you are installing Predictive Maintenance and Quality for the first time,
use the server artifact installer that is provided with the fix pack updates instead
of the server artifacts installer that is provided with the original version of the
product.

If you already have a Predictive Maintenance and Quality environment up and
running, run the server artifacts installer that is provided with the fix pack updates
to update your environment.

Before you begin
Ensure that you are logged in as root.

You must have a Firefox, version 10 or earlier, or SeaMonkey, version 2.9 or earlier,
web browser installed and set as your default web browser on the computer from
where you run the installation.

Procedure

1. In a terminal window, go to the USB hard disk drive that you mounted or to
the directory where you copied the installation files.

2. Go to the ServerArtifacts/diskl directory.

3. Type the following command to change the permissions for the installation
files:

chmod -R 755 =
4. Enter the following command:
./1aunchpad.sh
5. Review the information in the Launchpad panels.

6. Click Install Server Artifacts > Predictive Maintenance and Quality Server
Artifacts Accelerator to start the Deployment Wizard to install the server
artifacts.

7. Select one of the following options.
* If you are installing Predictive Maintenance and Quality for the first time,
select New Customer.

* If you already have a Predictive Maintenance and Quality environment up
and running, select Existing Customer.

Important: Ensure that you select the correct option for your environment. If
you already have existing Predictive Maintenance and Quality server artifacts
that are deployed, you must select Existing Customer. If you do not have the
server artifacts that are deployed, select New Customer.

8. Follow the prompts to install the server artifacts.
9. On the Select Tasks page, select all nodes.

Setting port numbers for the Deployment Wizard to use

If you opened ports for the installation of IBM Predictive Maintenance and Quality
components, you must set those port numbers in the Deployment Wizard.

Procedure

1. In the Deployment Wizard, click Edit > Preferences.
The Deployment Preferences window appears.

2. Enter 30000 in the Data Port Number box.
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Important: Ensure that you enter the port number that you opened if you
selected a port other than 30000.

3. Enter 35000 in the Communication Port Number box.

Important: Ensure that you enter the port number that you opened if you
selected a port other than 35000.

4. If you are using the computer on which you are running the installation as a
node, do the following steps:

a. Click Target Computer Settings.
b. Select localhost in the Target Computer field.

c. Enter the communication port number that you set in the Communication
Port field. For example, enter 35000.

Note: The RMI Registry Port is unavailable if you are using localhost as a
node.

Specifying the target computers on which you will install the server

artifacts

You must specify a each computer on which you installed an IBM Predictive
Maintenance and Quality node. Ensure that you identify the correct computer for
each node.

Before you begin
You must have root access on each computer on which you install a node.

You might have to change a setting in a configuration file on your target computer
to allow the Deployment Wizard to access the computer as root. Use the
following steps if you receive a message that says the connection to the target
computer was refused:

1. On the target computer, go to the /etc/ssh directory and open sshd_config for
editing.
2. Change the PermitRootLogin property to yes.

3. Save the file. You may have to restart the server for the change to take effect.

Procedure

1. On the Specify Target Computers pages of the Deployment Wizard, enter the
name or IP address of the computer on which you installed the node you are
prompted for in the Target Computer box.

The Deployment Wizard prompts you for each node computer.

If you installed a node on the computer where you are running the
Deployment Wizard, enter Tocalhost.

2. Click Add.

a. When you enter a computer other than localhost, in the Target Computer
Credentials box, enter the User ID and Password for the root user.

Important: Ensure that you enter the credentials for the root user on the
target computer.

b. Click Test Login.
c. Click Add.
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The computer that you entered appears in the Selected target computers
box.

3. Do the following steps if you opened ports for the installation.

a.

b.
c.
d

Click Edit > Preferences.
Click Target Computer Settings.
Select the computer name or IP address in the Target Computer field.

Enter the communication port number that you set in the Communication
Port field. For example, enter 35000.

Enter the Data Port Number that you set in the RMI Registry Port field.
For example, enter 30000.

Note: If you are using localhost as a node in the installation, the RMI
Registry Port is unavailable.

4. In the Selected target computers box, select the target computer, and click Test
Connections.

Important: Test Connections tests the connection, tests the credentials, and
locates or enables a deployment agent on the target computer. You must have
an active deployment agent on each target computer.

It

you receive an error message after you click Test Connections, you might

have to change some settings on your computers.

Edit your iptable settings or temporarily disable your firewall. For more
information, see [“Computer firewall settings required for the installation” on|
-ae 10,

Compare and correct your domain name system (DNS) settings for each
computer. For example, type sudo system-config-network. Select DNS
configuration, and ensure that your host name domain and DNS search path
settings are correct.

Ensure that the /etc/hosts file has the correct entries. For an example, see
[“Test Connections validation errors” on page 67|

5. Click Next.
6. Repeat the steps for each node computer.

Configuring parameters for the server artifacts installation

38

The Deployment Wizard displays some default values for each component. You
can accept the default values or change them to suit your environment.

Procedure

Use the following table to verify or enter values in each field on each panel of the
Deployment Wizard.

Table 15. Data node parameters

Field Default or example value Description
Data Node Deployment /opt/IBM/PMQ/Data The location where the
Location server artifacts are to be

installed on the Data node
computer.
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Table 15. Data node parameters (continued)

Field

Default or example value

Description

DB2 Instance Owner User
Name

db2instl

The user ID that controls the
DB2 processes and owns the
directories that are used by
the database instance.

DB2 Instance Owner
Password

There is no default value for
this field.

The password for the DB2
instance owner user.

Note: Ensure that you use
the same password as you
provided during the server
installation.

Table 16. Enterprise Service Bus (ESB) node parameters

Field

Default or example value

Description

Enterprise Service Bus Node
Deployment Location

/var/PMQ

The location where the
server artifacts are to be
installed on the ESB node
computer.

Installation Location of
Message Broker

/opt/ibm/mgsi/8.0.0.1

The location where
WebSphere Message Broker
is installed. This directory is
on the ESB node computer's
file system.

Websphere Message Queue
Location

/opt/mgm

The location where
WebSphere Message Queue
is installed. This directory is
on the ESB node computer's
file system.

Broker Name

pmgbroker

The broker name that you
created.

Queue Manager Name

pmgmanager

The Queue Manager name
that you created.

Execution Group

pmqgroup

The name of a group of
message flows that are
assigned to a broker that you
created.

PMQIntegration SPSS
WebService URL

http://
analytics_node_name:port/
scoring/services/
Scoring.HttpV2

Where analytics_node_name
is the name or IP address of
the Predictive Analytics node
computer, and port is the
HTTP port for the
WebSphere instance, for
example 9080.

PMQMaximolntegration
SPSS WebService URL

http://maximo_server_name:
port/meaweb/services/
EXTSYS1 _MXWOInterface

Where maximo_server_name is
the name or IP address of
the computer where IBM
Maximo® Asset Management
is running, and port is the
port number.
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Table 17. Business Intelligence (Bl) node parameters

Field

Default or example value

Description

Business Intelligence
Deployment Location

/opt/IBM/PMQ/BI

The location where the
server artifacts are to be
installed on the BI node
computer.

Cognos Install Location

/opt/ibm/cognos/c10_64

The location where IBM
Cognos BI is installed. This
directory is on the BI node
computer's file system.

WebSphere Install Location |/opt/IBM/WebSphere/ The location where
AppServer WebSphere is installed. This
directory is on the BI node
computer's file system.
DB2 Instance Home /home/db2inst1 The home directory of the

Directory

database instance owner.

Cognos BI Dispatcher URI

http://bi_node_name:9080/
p2pd/serviet/dispatch

The URL to the IBM Cognos
BI dispatcher, where
bi_node_name is the name or
IP address of the BI node
computer.

DB2 Database Instance User
Name

db2instl

The user ID for the IBM
Cognos content store
database.

DB2 Database Instance
Password

There is no default value for
this field.

The password for the
database instance owner
user.

DB2 Database Port Number

50000

The port number for the IBM
DB2 database server.

DB2 Database Hostname

There is no default value for
this field.

The name or IP address of
the Data node computer.

Table 18. Analytics node parameters

Field

Default or example value

Description

Analytics Deployment
Location

/opt/IBM/PMQ/Analytics

The location where the
server artifacts are to be
installed on the Analytics
node computer.

Modeler Server Install
Location

/usr/IBM/SPSS/
ModelerServer/15.0

The location where the
Modeler Server is installed.

Collaboration and
Deployment Services Install
Location

/opt/IBM/SPSS/Deployment/
5.0/Server

The location where IBM SPSS
Collaboration and
Deployment Services is
installed. This location is on
the Analytics node computer.

Table 19. Master Data Management (MDM) node parameters

Field

Default or example value

Description

Master Data Deployment
Location

/opt/I1BM/PMQ/MDM

The location where the
server artifacts are to be
installed on the MDM node
computer.
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Starting the installation of the server artifacts

After you enter all of the required fields in the Deployment Wizard, you can start
the installation of the server artifacts.

Procedure

On the Summary Panel of the Deployment Wizard, click Deploy all.

Note: If you choose to deploy the tasks individually, you must click Deploy task
for each task in the order that the tasks appear on the Summary panel.

Complete the configuration of the server components

After you have installed the IBM Predictive Maintenance and Quality server
artifacts, you can complete the configuration of the server components.

Verifying the configuration of IBM SPSS Collaboration and
Deployment Services

To complete the configuration of IBM SPSS Collaboration and Deployment Services
Server, you must verify the URL Prefix value for your environment.

Procedure

1.
2.

10.

Open a web browser.
In the address bar, type the address for the Collaboration and Deployment
administration console.

The address is http://analytics_node_name:9080/config, where
analytics_node_name is the name or IP address for the Predictive Analytics
node computer.

Enter the Login name and Password for the administrator user, and click
Login.

The default Login name is admin, and the default Password is admin.

On the Configuration panel, under Setup, click URL Prefix.

In the URL Prefix box, verify that the address is http://

analytics _node_name:9080, where analytics _node_name is the name or IP
address of the Analytics node computer.

If the value is correct, you do not have to complete the remaining steps in this
task.

If the value is not correct, enter the name or IP address of the Analytics node
computer, and click Set.

Open the WebSphere Administrative Console in your web browser.

The address is http://analytics_node_name:9060/ibm/console, where
analytics_node_name is the name or IP address for the Analytics node
computer. 9060 is the default port number for the WebSphere Administrative
Console.

Click Log in.
You do not need to enter a value in the User ID box.

Under Applications > Application Types > WebSphere Enterprise
Applications, select
IBM_SPSS_Collaboration_and_Deployment_Services_5.0, and click Stop.
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11.

Select IBM_SPSS_Collaboration_and_Deployment_Services_5.0, and click
Start to restart the application and apply the changes.

Configuring the MDM node

To configure the Master Data Management (MDM) node, you must log in to the
MDM administration console and import content files.

The content files are installed onto the MDM node computer by the Server Artifact
installer. You must copy the content files from the MDM node to a computer where
you have Microsoft Internet Explorer installed.

Procedure

1.

© N oA

©

Copy the MDM node contents to your Microsoft Windows-based computer
with an FTP client or by using a shared directory.

The contents files are installed to /opt/ibm/PMQ by default on the MDM node
computer. The contents file is named IBMPMQ.zip.

In Microsoft Internet Explorer, go to the MDM administration console.

The address is http://mdm_node name:7507/utils/enterLogin.jsp, where
mdm_node_name is the name or IP address of the MDM node computer.

In User name, enter Admin.

Note: These values are case-sensitive.

In the Password box, enter trinitron.

In the Company box, enter IBMPMQ.

Click Login.

Click System Administrator > Import Environment.

In the Import Company Environment box, browse to and select the
IBMPMQ. zip file that you copied.

Click Import.

Log out, and log back in to the MDM administration console to ensure that
the import was completed.
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Chapter 6. Fix pack updates for the server artifacts

IBM Predictive Maintenance and Quality fix pack updates for the server artifacts
affect the Business Intelligence (BI) node and the Enterprise Service Bus (ESB)
node.

Updating the IBM Cognos Bl artifacts for Fix Pack 1

You must manually update the IBM Cognos Business Intelligence artifacts for IBM
Predictive Maintenance and Quality version 1 fix pack 1.

Procedure

10.

11.
12.

13.

© Copyright IBM Corp. 2013

1.
2.

© N oA

Log in to the BI node computer as root.

Copy the file IBMPMQ from /opt/IBM/PMQ/<BI time stamp>/reports directory to
the /opt/ibm/cognos/c10_64/deployment directory.

Note: The file path is case-sensitive.
In the address bar, type the address for the IBM Cognos BI portal.

The address is http://bi_node_name/ibmcognos/, where bi_node_name is the
name or IP address for the Bl node computer.

Note: Ensure that you add the trailing / to the URL.
IBM Cognos Connection appears.

Click Administer IBM Cognos content.

On the Configuration tab, click Content Administration.
On the toolbar, click New Import.

Select the IBMPMQ deployment archive and click Next.

If you want, type a unique name and a description and screen tip for the
deployment archive, select the folder where you want to save it, and then
click Next.

Select the content that you want to include in the import. To ensure that the
target package or folder exists in the target content store, click Edit next to the
package, and check that location is correct. Click Next.

In the Specify the general options pane, click Next.
The summary information appears.

Review the summary information and click Next.
Select the action that you want:

* To run the import one time, click Save and run once. Click Finish, specify
the time and date for the run, then click Run. Review the run time and
click OK.

* To schedule at a recurring time, click Save and schedule. Click Finish, and
then select frequency and start and end dates. Click OK.

Tip: To temporarily disable the schedule, select the Disable the schedule
check box.

* To save without scheduling or running, click Save only and click Finish.
When the import is submitted, click OK.
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14. When the import is complete, click Launch > IBM Cognos Connection to
view the imported content.

IBM WebSphere Message Broker artifacts

IBM WebSphere Message Broker archive (BAR) files, script files, and project
interchange files are provided.

IBM WebSphere Message Broker archive files

The following WebSphere Message Broker archive (BAR) files are configured by
using command-line parameters:

* PMQEventDataload.bar

* PMQMaximolIntegration.bar
* PMQIntegration.bar

* PMQMasterDataload.bar

IBM WebSphere Message Broker script files

The following script files are used to deploy the BAR files by using command-line
parameters:

* credentials.properties

* PMQIntegration.properties

* PMQMaximoIntegration.properties
* Queues.txt

* sql.properties

IBM WebSphere Message Broker project interchange files

The following files are project interchange files:
* PMQEventDataload_PI.zip

* PMQMaximoIntegration PI.zip

* PMQIntegration_PI.zip

* PMQMasterDataload PI.zip

Apply fix pack updates to WebSphere Message Broker
artifacts - no customization

Follow these steps to update the artifacts WebSphere Message Broker for IBM
Predictive Maintenance and Quality fix pack 1 if you made no customization to the
WebSphere Message Broker code.

Procedure
1. Log on to the Enterprise Service Bus (ESB) node computer as the mgm user.

2. Check that the properties files placed at /var/PMQ/MQSIFileInput/
properties<TimeStamp> contain the correct web service end-point URL for the
SPSS scoring service and Maximo WorkOrder.

Note: <TimeStamp> is the time when the fix pack artifacts were copied to the
server by the installer.
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3. Opverride the web service end-point URLs of the Predictive Maintenance and
Quality MaximoIntegration.bar and PMQIntegration.bar with the following
commands:

mgsiapplybaroverride -b <Bar file> -k <ApplicationName> -p
<PropertiesFile>

PMQMaximolntegration.bar
Example: mqsiapplybaroverride -b /var/PMQ/MQSIFilelnput/
server<TimeStamp>/PMQMaximoIntegration.bar -k
PMQMaximoIntegration -p /var/PMQ/MQSIFilelnput/
properties<TimeStamp>/PMQMaximoIntegration.properties

PMQIntegration.bar:
Example: mqsiapplybaroverride -b /var/PMQ/MQSIFilelnput/
server<TimeStamp>/PMQIntegration.bar -k PMQIntegration -p
/var/PMQ/MQSIFilelnput/properties<TimeStamp>/
PMQIntegration.properties

4. Deploy the bar files with the following command:
mqsideploy Broker name -e EG name -a Bar file
List of bar files:

* PMQMasterDataload.bar

* PMQEventDatal.oad.bar

¢ PMQIntegration.bar

* PMQMaximolntegration.bar

Example: mgsideploy pmgbroker -e pmggroup -a /var/PMQ/MQSIFileInput/
server<TimeStamp>/PMQMasterDataload.bar

Apply fix pack updates to WebSphere Message Broker
artifacts - with customization

Follow these steps to update the artifacts for the WebSphere Message Broker for
IBM Predictive Maintenance and Quality fix pack 1 if you customized the
WebSphere Message Broker code.

Procedure
1. Log on to the Enterprise Service Bus (ESB) node computer as the mgm user.

2. From this location: /var/PMQ/MQSIFileInput/PMQSource<TimeStamp> import the
following files into the WebSphere Message Broker Toolkit in a new workspace:

* PMQEventDataload PI.zip
* PMQIntegration_PI.zip
e PMQMasterDataload PI.zip
e PMQMaximoIntegration PI.zip
3. Incorporate the changes manually to your existing files.

a. RTC Defect 1005: Handle runtime exceptions in message flows such as data
source not found in the computer name, or an incorrect data source name.

The following applications are affected:
* PMQEventDataLoad

¢ PMQIntegration

* PMQMasterDataLoad

* PMQMaximolntegration

To apply the fix, follow these steps:
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1) In the library named PMQCommonLibrary, compare the existing files
named ProcessError.esql and Error_Handler Compute.esql with the
new files.

2) Search for “Start of RTC Defect Fix 1005” in the new file to locate the
start of code change. The modified block of code ends with the
comment “End of RTC Defect Fix 1005”.

3) Replace or add the fix code from the new file to the existing file.

b. RTC Defect 698: Avoid Duplicate batch batch entries. Duplicate batch
batch entries must be rejected by the batch batch flow and written to error
logs.

The following application is affected:

» PMQMasterDatal.oad

To apply the fix, follow these steps:

1) Compare the existing batch_batch_Compute.esql file with the new file.

2) Search for “Start of RTC Defect Fix 698” in the new file to locate the
start of code change. The modified block of code ends with the
comment “End of RTC Defect Fix 698”.

3) Replace or add the defect fix code from the new file to the existing file.
c. RTC Defect 699: Implement the SPSS Version 2 scoring web service.

The following application is affected:

* PMQIntegration

To apply the fix, follow these steps:

1) Compare the existing files PMQIntegration_BuildRequest.esql,
PMQIntegration_GenerateEvent.esql, with the new files.

2) In the file PMQIntegration BuildRequest.esql, search for “Start of RTC
Defect Fix 699” to locate the start of the code change. The modified
block of code ends with the comment “End of RTC Defect Fix 699”.

3) In the file PMQIntegration GenerateEvent.esql search for “RTC Defect
Fix 699” PMQIntegration BuildRequest.esql to locate the line of code
that changed.

4) Replace or add the defect fix code from the new file to the existing file.
5) Open the PMQIntegration.msgflow.

6) Go to the HTTP Transport property of InvokeSPSS (SOAP Request)
node, change the web service URL to:

http://<localhost>:9080/scoring/services/Scoring.HttpV2

Where the <localhost> is the correct IP or DNS name of the SPSS server
where the scoring service is running.

d. RTC Defect 700: Fix the event processing code to support target namespace.
The following application is affected:
* PMQEventDatalLoad
To apply the fix, follow these steps:

1) Compare the existing StdEventLoad_LoadEvent.esql file with the new
file.

2) Search for the start of “RTC Defect Fix 700: Fix the event processing
code to support target namespace” in the new file. The modifications
end with the comment “End of RTC Defect Fix 700”.

e. RTC Defect 701: User friendly error messages must be shown.
The following application is affected:
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* PMQEventDatalLoad
To apply the fix, follow these steps:

1) Compare the existing StdEventLoad_LoadEvent.esql file with the new
file.

2) Search for the start of “RTC Defect Fix 701” in the new file. The
modifications end with the comment “End of RTC Defect Fix 701”.

3) Replace or add the defect fix code from the new file to the existing file.
f. RTC Defect 1006: Fix Maximo asset mapping when CLASSTRUCTUREID is

missing.

The following application is affected:

* PMQMaximolntegration

To apply the fix, follow these steps:

1) Compare the existing maximo_asset.map file with the new file. In the new
file, there is a new IF block for CLASSSTRUCTUREID, which is mapped
to group_type_member_cd_1 only when CLASSSTRUCTUREID is not
empty.

2) Replace or add the defect fix code from the new file to the existing code.

3) Open the WorkorderCreation.msgflow and go to the HTTP Transport
property of InvokeWorkOrder (SOAP Request) node.

4) In the URL http://<localhost>:9080/meaweb/services/
EXTSYS1_MXWOInterface

Where <localhost> is the IP or DNS name of the Maximo server where
the work order service is running.

g. RTC Defect 2922: For null <value_type_cd> /<value_type_cd>, data does
not get populated to the RESOURCE_PROFILE tables.

The following application is affected:
* PMQEventDataLoad
To apply the fix, follow these steps:

1) Compare the existing StdEventLoad_LoadEvent.esql file with the new
file. In the new file, search for the start of “RTC Defect Fix 2922". The
modifications end with “End RTC Defect Fix 2922”.

2) Replace or add the defect fix code from the new file to the existing file.

h. RTC Defect 3939: Error when importing Project interchange
PMQMaximolntegration_PI.zip in to WMB 8.0.0.3 Toolkit.

The following application is affected:
* PMQMaximolntegration
To work around this problem, follow these steps:

1) Delete xml.xsd from <WorkSpace Path>\PMQMaximoIntegration\
IBMdefined\org\w3\www\xm1\_1998\namespace\xml.xsd

2) Clean and build the workspace.

4. Clean and build your existing workspace so the changes are reflected in all of
the Predictive Maintenance and Quality applications, and redeploy the
applications.
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Chapter 7. Installation of the client components

There are several client components that are included with IBM Predictive
Maintenance and Quality. You can install the components as you require.

Important: The client components must be installed on computers running the
Microsoft Windows 7 64-bit operating system.

Important: Install the client components only after you successfully install the
server components.

Client components

The following client components for IBM Predictive Maintenance and Quality are
available to be installed.

Database connectivity

IBM DB2 Connect” must be installed to enable connectivity to the analytics
database.

Predictive modeling and decision management

Install the following components so that you can modify or create predictive
models and so that you can perform decision management tasks:

* IBM SPSS Collaboration and Deployment Services Deployment Manager
* IBM SPSS Modeler Client

+ IBM SPSS Statistics Client

* IBM SPSS Text Analytics Client

Optionally, install the following components:

* IBM SPSS Collaboration and Deployment Services Documentation
» IBM SPSS Decision Management Documentation

* IBM SPSS Modeler Client Documentation

¢ IBM SPSS Statistics Desktop

Predictive Maintenance and Quality version 1.0 includes entitlements for the
following SPSS licenses:

e SPSS Modeler Premium 15 Authorized User
e SPSS Statistics Standard 21 Authorized User

Business intelligence

Install IBM Cognos Framework Manager so that you can modify the reporting
model metadata.

Note: You must install DB2 Connect before you can use IBM Cognos Framework

Manager. Ensure that you restart the computer after you install DB2 Connect, and
that you catalog the databases before you use Framework Manager.
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Optionally, install the following components:
* IBM Cognos Business Intelligence Samples
* IBM Cognos Dynamic Query Analyzer

* IBM Cognos for Microsoft Office

* IBM Cognos Lifecycle Manager

* IBM Cognos Mobile

¢ IBM Cognos Real-time Monitoring

* IBM Cognos Software Development Kit

* IBM Cognos Supplementary Languages Documentation
Enterprise service bus

Install the following components:
* WebSphere Message Broker Toolkit
¢ WebSphere MQ for Windows

Use the WebSphere Message Broker Toolkit to create, manage, deploy, and delete
message flows and associated resources in a development environment.

Starting the installer for the client components

50

The IBM Predictive Maintenance and Quality client installers are provided on the
same USB hard disk drive as the server and content installers.

Important: The Deployment Wizard copies the installers to your computer. You
must run each installer individually after they are copied to your computer.

Procedure

1. Insert the Predictive Maintenance and Quality USB hard disk drive into the
USB port of your Microsoft Windows 7-based computer.

Go to the Client/diskl directory.
Double-click Taunchpad64.exe.
Review the information in the Launchpad panels.

o k0N

Click Install Client > Predictive Maintenance and Quality Client Accelerator
to start the Deployment Wizard.

6. On the Select Tasks panel, select the groups of clients you want to install, and
click Next to select the client components that you want to install.

Important: The required client components include the following:

* WebSphere Message Broker Toolkit

¢ WebSphere MQ for Windows

* IBM SPSS Collaboration and Deployment Services Deployment Manager
* IBM SPSS Modeler Client

* IBM SPSS Statistics Desktop

* IBM SPSS Statistics Client

* IBM SPSS Text Analytics Client

* IBM Cognos Framework Manager

7. Enter a location for each client component installer to be copied to. The default
is C:\IBM\PMQ\Client Installer.
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8. On the Summary Panel, click Deploy all.

9. After the client installers are copied to your computer, you must install each
client individually by using its installer.

Installing IBM SPSS Collaboration and Deployment Services
Deployment Manager

You must install IBM SPSS Collaboration and Deployment Services Deployment
Manager to complete the configuration of IBM Predictive Maintenance and Quality.

Install IBM SPSS Collaboration and Deployment Services Deployment Manager on
a computer running the Microsoft Windows 7 operating system.

Procedure

1. Go to the install_location\Client Installer\Analytics\IBM SPSS
Collaboration and Deployment Services Deployment Manager directory.
By default, the install_location is C:\IBM\PMQ\.

2. Extract the installer files from the zip file.

3. Double-click install.exe to start the IBM SPSS Collaboration and Deployment
Services Deployment Manager installation.

4. Follow the steps in the wizard to install the client component.

For more information about the installation of Deployment Manager, see the
[lBM SPSS documentation| (pic.dhe.ibm.com/infocenter/spsscads/v5r0m0/
index.jsp).

Adding a content server connection for IBM SPSS
Collaboration and Deployment Services

You must add a connection to your IBM SPSS Collaboration and Deployment
Services repository in the IBM SPSS Collaboration and Deployment Services
Deployment Manager client.

After you add the connection, the server folder displays in the Content Explorer,
and you can log in to the server.

Procedure

1. On your Microsoft Windows computer, start IBM SPSS Collaboration and
Deployment Services Deployment Manager. For example, click Start >
Deployment Manager.

2. Click File > New > Content Server Connection.

3. In the Connection Name box, enter a name for your Collaboration and
Deployment Services repository.

4. In the Host box, enter the name or IP address of the Predictive Analytics node
computer.

5. In the Port box, enter 9080.

9080 is the port number used by the WebSphere Application Server instance.
Click Finish.

Click the connection name that you created.

In the User ID box, enter admin.

In the Password box, enter admin.

Click OK.

© ©®®» N

Chapter 7. Installation of the client components 51


http://pic.dhe.ibm.com/infocenter/spsscads/v5r0m0/index.jsp?topic=%2Fcom.ibm.spss.cads.install.dm.doc%2Fthick_install_overview.htm

Adding users and groups to IBM SPSS Collaboration and
Deployment Services

You use IBM SPSS Collaboration and Deployment Services Deployment Manager
to manage users and groups. You must add an administrator user for IBM
Predictive Maintenance and Quality.

Procedure
In Deployment Manager, click Tools > Server Administration.
Click Click here to define a new administrative server connection.

In the Name box, enter a name for your server, and click Next.

PoOnp

In the Host box, enter the name or IP address of Predictive Analytics node
computer.

o

In the Port box, enter the port number of for the WebSphere instance. The
default value is 9080.

Click Finish.
Double-click the connection name that you created.

© N o

In the User ID box, enter admin.
9. In the Password box, enter admin.
10. Click OK.
11. Expand Users and Groups, and double-click Local User Repository.
12. Select Show all available users/groups.
13. Click New Group.
a. Enter administrator.
b. Select Show all available users.
¢. Under Available users, move the admin user to Groups contains users.
d. Click OK.
14. Click New Group.
a. Enter DM Administrator.
b. Select Show all available users.
c. Under Available users, move the admin user to Groups contains users.
d. Click OK.
15. Click New Group.
a. Enter DM Users.
b. Select Show all available users.
¢. Under Available users, move the admin user to Groups contains users.
d. Click OK.
16. Double-click Roles.
17. Click New Role.
a. In the Role Name box, enter DM Administrator.
b. Click Select All to add all actions for this user role.
c. Click OK.
d. Select the DM Administrator role, and click Edit Users and Groups.
e. Click Show all available users/groups.
f.

Under Available users, move the DM Administrator group to
Users/Groups Assigned to Role.

g. Click OK.
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18. Click New Role.
a. In the Role Name box, enter DM User.
Click Select All to add all actions for this user role.
Click OK.
Select the DM User role, and click Edit Users and Groups.
Click Show all available users/groups.

~o oo o

Under Available users, move the DM Users group to Users/Groups
Assigned to Role.

g. Click OK.

Importing the Predictive Maintenance and Quality resource
definitions into IBM SPSS Collaboration and Deployment
Services

Resource definitions include credential definitions, data source definitions, message
domains, promotion policies, server definitions, and server cluster specifications.
These resources are required for running jobs.

You must import these resource definitions into IBM SPSS Collaboration and
Deployment Services Deployment Manager.

The resource files are installed onto the Predictive Analytics node computer by the
Server Artifact installer. You must copy the content files from the Analytics node to
the computer where you installed Deployment Manager.

Procedure

1. Copy the Analytics node contents to your Windows-based computer using
either an FTP client or by using a shared directory.

The contents files are installed to /opt/ibm/PMQ by default on the Analytics
node computer.

2. On your Windows-based computer, in Deployment Manager, click Content
Explorer.

3. Right-click Content Repository, and click Import.

4. Browse to and select the file named PredictiveMaintenance.pes in the
directory where you copied the Analytics node contents.

5. Click Open.
6. Accept the default options in the Import window, and click OK.

Adding credential definitions to IBM SPSS Collaboration and
Deployment Services

You must add user credential definitions in IBM SPSS Collaboration and
Deployment Services Deployment Manager. You must add the credentials for your
IBM SPSS admin user, the database instance owner, and the root user on the
Predictive Analytics node computer.

Procedure

1. In Deployment Manager, click Content Explorer.

2. Expand Resource Definitions > Credentials.

3. Right-click Credentials, and click New > Credentials Definition.
a. In the Name box, enter admin, and click Next.
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In the User ID box, enter admin.

In the Password box, enter admin.

In the Security Provider box, select Local User Repository.

. Click Finish.

4. Right-click Credentials, and click New > Credentials Definition.
In the Name box, enter db2inst1, and click Next.

In the User ID box, enter db2inst1.

In the Password box, enter the password for your db2instl user.

® ao0oT

Leave the Security Provider box blank.

. Click Finish.

5. Right-click Credentials, and click New > Credentials Definition.
a. In the Name box, enter modeler, and click Next.
b. In the User ID box, enter root.

c. In the Password box, enter the password for the root user on the Analytics
node computer.

® a0 o p

d. Leave the Security Provider box blank.
e. Click Finish.

Adding server definitions to IBM SPSS Collaboration and
Deployment Services
You must add server definitions in Deployment Manager.

If you are not using a computer that is running the Microsoft Windows 7 operating
system, some entries, such as server types, may not display correctly.

Procedure
1. In Deployment Manager, click Content Explorer.
2. Expand Resource Definitions.
3. Right-click Servers, and click New > Server Definition.
a. In the Name box, enter localhost, and click Next.
b. In the Type box, select Content Repository Server.
c. Click Next.
d. In the Host box, enter the name or IP address of Analytics node computer.
e. In the Port box, enter 9080.
f. Click Finish.
4. Right-click Servers, and click New > Server Definition.
In the Name box, enter modeler, and click Next.
In the Type box, select Modeler Server.
Click Next.
In the Host box, enter the name or IP address of Analytics node computer.
In the Port box, leave the default value 28052.

In the Default data path box, enter the path to the data directory on
Analytics node computer. For example, enter /usr/IBM/SPSS/ModelerServer/
15.0

g. Click Finish.

-0 o0 OTp
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Creating scoring configurations

You must create scoring configurations for IBM Predictive Maintenance and
Quality. You create these configurations in IBM SPSS Collaboration and
Deployment Services Deployment Manager.

You must select the appropriate Output data returned settings for the steam you
are configuring:

Table 20. Output data returned settings for each IBM Predictive Maintenance and Quality

stream

Stream name Scoring service name Output data returned setting
Health_Score_Model.str RESOURCE_HEALTH_SCORE HEALTH_SCORE

Life Time RESOURCE_LIFETIME_SCORE RESOURCE_ID

Analysis_Modell.str

EXPECTED_DEVICE_LIFETIME

Asset_Recommendation.str RESOURCE_RECOMMENDATION HEALTH_RECOMMENDATION

Procedure

11.

In Deployment Manager, click Content Explorer.

Under Content Repository > PredictiveMaintenance, right-click the model for
which you want to create the scoring. For example, right-click
Health_Score_Model.str.

Click Configure Scoring.

In the Configure Scoring Model dialog box, click Next.
On the Data provider settings panel, click Next.

On the Input data order panel, click Next.

On the Input data returned settings panel, click Next.

On the Output data returned settings panel, select the appropriate score, and
click Next. For example, for Health_Score_Model.str, select HEALTH_SCORE.

On the Logging settings panel, click Next.
On the Advanced settings panel, click Finish.
Repeat these steps for each stream you want to configure.
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Chapter 8. Fix pack updates for the client components

Use the product documentation to apply fix pack updates to the IBM Predictive
Maintenance and Quality client components.

IBM DB2 Client

For more information about IBM DB2 fix packs, see the [DB2 Version 9.7 Fix Pack §
|for Linux, UNIX, and Windows fix pack document| (http:/ /www.ibm.com/
support/docview.wss?uid=swg24034634).

For more information about installing IBM DB2 Connect on Windows operating
systems, see the [BM DB2 documentation| (pic.dhe.ibm.com/infocenter/db2luw /
v91r7 /index jsp?topic=%2Fcom.ibm.db2.luw.gb.dbconn.doc%2Fdoc
%2Ft0008456.html).

WebSphere Message Queue

For more information about WebSphere Message Queue fix packs on Windows
operating systems, see the [Readme for WebSphere MQ V7.5, Fix Pack 7.5.0.2|
(www.ibm.com/support/docview.wss?uid=swg27039002).

You can download the fix pack by going to [IBM Fix Central| (www.ibm.com/
support/fixcentral/), and searching for 7.5.0-WS-MQ-Windows-FPO0OO1.

For more information about installing WebSphere Message Queue clients, see the
[WebSphere Message Queue documentation| (pic.dhe.ibm.com/infocenter/wmqv?7/
v7r5/index jsp?topic=%2Fcom.ibm.mq.ins.doc%2Fq009030_.htm).

WebSphere Message Broker Toolkit

For more information about installing WebSphere Message Broker Toolkit fix packs,
see the [WebSphere Message Broker Toolkit Version 8.0 Fix Pack 3 document]|
(www.ibm.com/support/docview.wss?rs=849&uid=swg24035893).

IBM SPSS Collaboration and Deployment Services Deployment
Manager

For more information about installing IBM SPSS Collaboration and Deployment
Services Deployment Manager fix packs, see the |SPSS Collaboration andl
[Deployment Services 5.0 Fix Pack 2 document] (www.ibm.com/ support/
docview.wss?rs=849&uid=swg24034742).

IBM SPSS Modeler

For more information about installing IBM SPSS Modeler fix packs, see the
Notes® - IBM SPSS Modeler 15.0 Fix Pack 2 document (www.ibm.com /support/
docview.wss?rs=849&uid=swg27038311).

For more information about installing IBM SPSS Modeler Premium Add-ons fix
packs, see the [SPSS Modeler 15.0 Fix Pack 2 - Premium Add-ons document|
(www.ibm.com/support/docview.wss?rs=849&uid=swg24034740).
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Chapter 9. Uninstallation of the IBM Predictive Maintenance
and Quality components

Follow the uninstall instructions for each of the Predictive Maintenance and
Quality components to uninstall the product.

Uninstalling components from the Predictive Analytics node computer

Follow the uninstall instructions for each component on the Analytics node
computer.

Procedure

1. To uninstall the IBM DB2 client, see the [[BM DB2 documentation|
(pic.dhe.ibm.com/infocenter/db2luw /v917).

2. To uninstall IBM SPSS Collaboration and Deployment Services, see the
[SPSS documentation| (pic.dhe.ibm.com/infocenter /wasinfo/v8r0).

a. Go to the /opt/ibm/InstallationManager/eclipse directory, and run IBMIM.
b. Click Uninstall, and follow the steps to uninstall the product.

3. To uninstall WebSphere Application Server, see the [WebSphere documentation|
(pic.dhe.ibm.com/infocenter/wasinfo/v8r0).

a. Go to the /opt/ibm/InstallationManager/eclipse directory, and run IBMIM.
b. Click Uninstall, and follow the steps to uninstall the product.

Note: If WebSphere Application Server processes are running and prevent you
from uninstalling the product, you must stop the server process. Go to the
/opt/ibm/WebSphere/AppServer/profiles/profile_name/bin directory, and type
./stopServer.sh serverl.

4. To uninstall IBM Installation Manager, see the [[BM Installation Manager|
[information centet] (pic.dhe.ibm.com/infocenter/install /v1r6).

a. Go to the /var/ibm/InstallationManager/uninstall directory, and run
uninstall.

b. Follow the steps to uninstall Installation Manager.

Uninstalling components from the Bl node computer

Follow the uninstall instructions for each component on the Business Intelligence
(BI) node computer.

Procedure

1. To uninstall the IBM DB2 client, see the [BM DB2 documentation|
(pic.dhe.ibm.com/infocenter/db2luw /v917).

2. To uninstall IBM Cognos Business Intelligence, see the [[BM Cognos Bl
(pic.dhe.ibm.com/infocenter/cbi/v10r2m0).

a. Go to the /opt/ibm/cognos/c10_64/uninstall directory.
b. Type ./uninst -u, and press Enter.

c. Follow the steps to uninstall the product.

3. To uninstall IBM HTTP Server, see the [[BM HTTP Server for WebSpherd
[Application Server documentation| (pic.dhe.ibm.com/infocenter/wasinfo/v8r0).
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a. Go to the /opt/ibm/InstallationManager/eclipse directory, and run IBMIM.
b. Click Uninstall, and follow the steps to uninstall the product.

4. To uninstall WebSphere Application Server, see the [WebSphere documentation|
(pic.dhe.ibm.com/infocenter /wasinfo/v810).

a. Go to the /opt/ibm/InstallationManager/eclipse directory, and run IBMIM.
b. Click Uninstall, and follow the steps to uninstall the product.

Note: If WebSphere Application Server processes are running and prevent you
from uninstalling the product, you must stop the server process. Go to the
/opt/ibm/WebSphere/AppServer/profiles/profile_name/bin directory, and type
./stopServer.sh serverl.

5. To uninstall IBM Installation Manager, see the [BM Installation Manager]|
|inf0rmati0r1 cented (pic.dhe.ibm.com/infocenter/install /v1r6).

a. Go to the /var/ibm/InstallationManager/uninstall directory, and run
uninstall.

b. Follow the steps to uninstall Installation Manager.

Uninstalling components from the ESB node computer

Follow the uninstall instructions for each component on the Enterprise Service Bus
(ESB) node computer.

Procedure
1. To uninstall WebSphere Message Broker, see the [WebSphere Message Broker|

(publib.boulder.ibm.com/infocenter /wmbhelp /v8r0mO0).
2. To uninstall WebSphere Message Queue, see the[WebSphere Message Queue|

(publib.boulder.ibm.com/infocenter/wmqvé6/v6r0).

Uninstalling components from the MDM node computer

60

Follow the uninstall instructions for each component on the Master Data
Management (MDM) node computer.

Procedure

1. To uninstall the IBM DB2 client, see the [[BM DB2 documentation|
(pic.dhe.ibm.com/infocenter/db2luw /v9r7).

2. To uninstall InfoSphere Master Data Management Server, see the [BM MDM
(pic.dhe.ibm.com/infocenter /mdm/v10rOm0).

a. Go to the /opt/IBM/MDMPIM/_uninst directory.
b. Type ./uninstall.bin, and press Enter.

c. Follow the steps to uninstall the product.

3. To uninstall WebSphere Application Server, see the [WebSphere documentation|
(pic.dhe.ibm.com/infocenter /wasinfo/v8r0).

a. Go to the /opt/ibm/InstallationManager/eclipse directory, and run IBMIM.
b. Click Uninstall, and follow the steps to uninstall the product.

Note: If WebSphere Application Server processes are running and prevent you
from uninstalling the product, you must stop the server process. Go to the
/opt/ibm/WebSphere/AppServer/profiles/profile_name/bin directory, and type
./stopServer.sh serverl.
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4. To uninstall IBM Installation Manager, see the [BM Installation Manager|
[information center] (pic.dhe.ibm.com/infocenter/install/v1r6).

a. Go to the /var/ibm/InstallationManager/uninstall directory, and run
uninstall.

b. Follow the steps to uninstall Installation Manager.

Uninstalling components from the Data node computer

Follow the uninstall instructions for each component on the Data node computer.

Procedure

To uninstall IBM DB2, see the IIBM DB2 documentation| (pic.dhe.ibm.com/
infocenter/db2luw /v9r7).
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Appendix A. Samples

Sample data is provided so that you can see the IBM Predictive Maintenance and
Quality solution work end-to-end.

Loading the sample data

Sample data is installed as part of the IBM Predictive Maintenance and Quality
server artifact installation. You can load the sample data to see an example of the
Predictive Maintenance and Quality solution from end-to-end.

Procedure

1. Log in to the Enterprise Service Bus (ESB) node computer as the mgm user.

2. Go to the /var/PMQ/MQSIFilelnput/PMQSampleData/Sample PMQ/MasterData-Setl
directory.

3. Copy the contents of that directory to the /var/PMQ/MQSIFileInput/
masterdatain directory one file at a time.

WebSphere Message Broker automatically loads the files from that directory.
The files are automatically removed after they are loaded.

Important: The files must be coped one at a time.

4. Go to the /var/PMQ/MQSIFilelnput/PMQSampleData/Sample PMQ/MasterData-Set?
directory.

5. Copy the contents of that directory to the /var/PMQ/MQSIFileInput/
masterdatain directory one file at a time.

Important: batch_batch_upsert_sample_pmg.csv must be loaded last.
6. Go to the /var/PMQ/MQSIFilelnput/PMQSampleData/Sample PMQ/EventData-Set3
directory.

7. Copy the contents of that directory to the /var/PMQ/MQSIFileInput/eventdatain
directory one file at a time.

Removing sample data

Before you load live production data in IBM Predictive Maintenance and Quality,
all sample data must be removed.

This procedure deletes all the contents of the event and master data tables. Its
scope is not limited to the supplied sample data and so any additional content that
is loaded is also deleted.

Before you begin
If test events were loaded from the sample master data, the test events must also
be removed. For more information, see the IBM Predictive Maintenance and Quality

Solution Guide.

Procedure
1. Type the following command to connect to the IBMPMQ datastore:
db2 "connect to IBMPMQ user user_name using password"
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Run SampleDeletes.sql in the location: /opt/IBM/PMQ/Data by using the
following command:

db2 "-tvf /opt/IBM/PMQ/Data/SampleDeletes.sql"

Type the following command to commit the transaction:

db2 "commit"

Type the following command to populate the master tables with NA rows:
db2 "call SCHEMA.POP_NA( 'EN' , 'English' , 'PMQ' , 'PMQ' )"

Ensure that the correct schema name is used, such as db2inst1

Type the following command to run the Calendar generation procedure:
db2 "call SCHEMA.Calendar_pop"

Type the following command to disconnect from the database:

db2 "connect reset"
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Appendix B. Products installed with IBM Predictive
Maintenance and Quality

The following products are installed with or available to be installed with
Predictive Maintenance and Quality.

Server components

© Copyright IBM Corp. 2013

IBM DB2 Enterprise Server Edition 9.7 for Linux on AMD64 and Intel EM64T
systems (x64) English
IBM DB2 9.7 Fix Pack 7 for Linux/x86-64 (64 bit), DB2 Server Fix Pack

IBM DB2 Enterprise Server Edition 9.7 Client for Linux on AMD64 and Intel
EMO64T systems (x64) English

IBM WebSphere Network Deployment 8.0 for Multiplatform, Multilingual
IBM WebSphere Network Deployment 8.0 Fix Pack 5

IBM WebSphere Network Deployment 8.0 Supplements Pack for Multiplatform
Multilingual

IBM Installation Manager 1.6 for Linux 64-bit Multilingual

IBM Cognos Business Intelligence Server 10.2.0 Linux x86 Multilingual
IBM WebSphere Message Broker V8.0.0.1 Linux x86-64 Multilingual

IBM WebSphere Message Broker 8.0 Fix Pack 2

IBM WebSphere Message Broker Explorer 8.0.0.2

IBM WebSphere Message Broker ODBC Database Extender (IE02)

IBM WebSphere Message Queue V7.5 for Linux on x86 64bit Multilingual

IBM SPSS Collaboration and Deployment Services Server 5.0 Red Hat Enterprise
Linux Multilingual

IBM SPSS Collaboration and Deployment Services Deployment Manager 5.0 Fix
pack 1

IBM SPSS Collaboration and Deployment Services Enterprise View Driver 64-bit
5.0 Red Hat Enterprise Linux Multilingual

IBM SPSS Collaboration and Deployment Services Web Installer for Deployment
Manager 5.0 Multiplatform Multilingual

IBM SPSS Collaboration and Deployment Services Enterprise Python Scripting
5.0 Red Hat Enterprise Linux Multilingual

IBM SPSS Modeler Server 64-bit 15.0 Linux Multilingual

IBM SPSS Modeler Server 64-bit 15.0 Fix Pack 1

IBM SPSS Data Access Pack 6.1 sp3 Multiplatform English
IBM SPSS Text Analytics Server 64-bit 15.0 Linux Multilingual

IBM SPSS Modeler 15.0 Collaboration and Deployment Services Adapter 64-bit 5
Linux Multilingual

IBM SPSS Modeler Collaboration and Deployment Services Adapter 15 Fix Pack
1

IBM SPSS Decision Management 7.0 Linux Multilingual
IBM SPSS Decision Management 7.0 Fix Pack 1

IBM SPSS Decision Management Modeler Extension Libraries 7.0 Linux
Multilingual
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IBM SPSS Decision Management Modeler Extension Libraries 7.0 Fix Pack 1
IBM SPSS Decision Management Modeler Advantage 7.0 Linux Multilingual
IBM SPSS Decision Management Modeler Advantage 7.0 Fix Pack 1

IBM SPSS Decision Management Customer Applications 7.0 Linux Multilingual
IBM SPSS Decision Management Customer Applications 7.0 Fix Pack 1

IBM SPSS Decision Management for Claims 7.0 Linux Multilingual

IBM SPSS Decision Management for Claims 7.0 Fix Pack 1

IBM SPSS Statistics 21.0 Collaboration and Deployment Services Adapter 64-bit
5.0 Linux Multilingual

IBM SPSS Statistics 21.0 Collaboration and Deployment Services Adapter 5.0 Fix
Pack 1

IBM SPSS Statistics - Essentials for Python 21.0 for Linux 64 Multilingual
IBM SPSS Statistics Server 64-bit 21.0 Linux Multilingual

IBM Infosphere Master Data Management Collaboration Server V10.1.0
Multiplatform Multilingual 10.1.0.0

Quick Start Documentation - IBM Infosphere Master Data Management V10.1.0
Multiplatform Multilingual

Client and optional components

IBM DB2 Connect Personal Edition 9.7 for Windows® on AMD64 and Intel®
EM64T systems (x64) English

IBM Cognos Framework Manager 10.2.0 Microsoft Windows Multilingual
IBM Cognos Business Intelligence Samples 10.2.0 Multiplatform Multilingual

IBM Cognos Supplementary Languages Documentation 10.2.0 Multiplatform
Multilingual

IBM Cognos Dynamic Query Analyzer 10.2.0 Multiplatform Multilingual

IBM Cognos for Microsoft Office 10.1.1 for Business Intelligence 10.2.0 Microsoft
Windows Multilingual

IBM Cognos Lifecycle Manager 10.2.0 Microsoft Windows English
IBM Cognos Mobile 10.2.0 Multiplatform Multilingual

IBM Cognos Real-time Monitoring 10.2.0 Multiplatform Multilingual
IBM Cognos Software Development Kit 10.2.0 Multiplatform English

IBM SPSS Collaboration and Deployment Services Deployment Manager 64-bit
5.0 Microsoft Windows Multilingual

IBM SPSS Collaboration and Deployment Services Documentation 5.0
Multilingual

IBM SPSS Modeler Client 64-bit 15.0 Microsoft Windows Multilingual

IBM SPSS Text Analytics Client 64-bit 15.0 Microsoft Windows Multilingual
IBM SPSS Modeler Client Documentation 15.0 Multilingual

IBM SPSS Decision Management Documentation 7.0

IBM SPSS Statistics Client 64-bit 21.0 Microsoft Windows Multilingual

IBM SPSS Statistics Client/Developer Installation Documentation 21.0
Multilingual

IBM Message Broker Toolkit V8.0.0.1 Windows 1 Multilingual
IBM Message Broker Toolkit Fix Pack 2

IBM Installation Manager V1.6.0 for Windows Multilingual
IBM WebSphere MQ V7.5 for Windows Multilingual
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Appendix C. Troubleshooting

This section contains troubleshooting information for the IBM Predictive
Maintenance and Quality installation.

Log in as root rather than su or sudo

To run the IBM Predictive Maintenance and Quality installation, you must log in to
the computer from where you run the installation as reot. Using su root or sudo
to run the installer is not supported in this version.

Browser not supported for the Launchpad

You must have a Firefox, version 10 or earlier, or SeaMonkey, version 2.9 or earlier,
web browser that is installed and set as your default web browser on the computer
from where you run the IBM Predictive Maintenance and Quality installation. If
you have another browser that is set as your default and want to keep your
existing default browser, you can temporarily use a supported browser for the
installation.

Procedure

1. On the computer from where you run the installation, download a supported
web browser. For example, download Firefox version 10.

2. Uncompress the downloaded file if necessary.

3. In a terminal window, type the following command:
export BROWSER=/path_to_supported browser

4. Then, start the Launchpad by typing the following command:
./launchpad.sh
The Launchpad should appear in the supported browser.

Installer does not launch

If the IBM Predictive Maintenance and Quality installer does not launch, ensure
that you have completed all of the prerequisite tasks and installed all of the
required rpm packages.

Test Connections validation errors

If you click the Test Connections button in the IBM Predictive Maintenance and
Quality installer and you receive an error, use the following tips to verify
communication between the Deployment Wizard and the target computer.

* Ensure that you entered a valid host name or IP address.

* Ensure that you can ping the target computer from the computer where you are
running the installation.

* Ensure that all of your computers have valid entries in the /etc/hosts file.
For example, ensure that your hosts file that resemble the following:

127.0.0.1 Tocalhost.localdomain localhost
## . ## . #4 . ## myserver.domain.com myserver
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* Ensure that your firewall is disabled or that the ports required for the
Deployment Wizard are open on all computers.

Viewing log files

Log files for the IBM Predictive Maintenance and Quality installation can be
displayed in the Deployment Wizard.

Procedure

1. To view log files in the Deployment Wizard, select the message, and click
Detailed messages or Master log.

2. If you clicked Detailed messages, select a message, and click View Details.

Temporary file locations

Temporary files are created during the IBM Predictive Maintenance and Quality
installation. You can find the location for the temporary files from the Deployment
Wizard.

Procedure

In the Deployment Wizard, click Edit > Preferences.
The path to the location for the temporary files is shown in the Path box.

Ensuring connectivity between the Analytics node and the Data node

computers

In IBM Predictive Maintenance and Quality, if the task for configuring the IBM
SPSS Collaboration and Deployment Services displays a database initialization
error, you may have to run the traceroute command to ensure communication
between the Predictive Analytics node and the Data node.

Procedure
1. On the Analytics node computer, enter the following command:

traceroute data_node_name

Where data_node_name is the name or IP address of the Data node computer.
2. Try the task again.

Modeler Server type not displaying in resource definitions

In IBM Predictive Maintenance and Quality, if the Modeler Server type does not
display in resource definitions in IBM SPSS Collaboration and Deployment Services
Deployment Manager, try closing Deployment Manager and opening it again.

Unable to import the company archive in MDM

If you cannot import the IBM Predictive Maintenance and Quality company
archive in the Master Data Management (MDM) console, you can manually import
the archive.

Procedure
1. Log in to the MDM node computer as root.
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2. Copy the IBMPMQ.zip file from /opt/IBM/PMQ/MDM_version directory to the

/opt/IBM/PMQ directory.

3. Enter the following command:

$TOP/bin/importCompanyFromZip.sh --company code=IBMPMQ
--zipfile_path=/opt/IBM/PMQ/IBMPMQ.zip

Error installing IBM Cognos Bl in IBM Predictive Maintenance and

Quality

The IBM Cognos Business Intelligence installer requires a specific library file in

order to run.

For information about the problem and the resolution, see the [[BM support page
(http:/ /www.ibm.com/support/docview.wss?uid=swg21612290).

Administration tool and product portal reference

The administrative tools and portals for IBM Predictive Maintenance and Quality
are located in several locations.

Access information for the tools and portals is provided in the following table.

Table 21. Administration tool and product portal reference

Administration tool or portal
and description

URL or location

WebSphere Integrated
Solutions Console

The WebSphere Integrated
Solutions Console is the

administration tool for
WebSphere.

The WebSphere Integrated
Solutions Console is running
on each node computer where
WebSphere is installed.

Use the console to start and
stop applications.

http://server_node_name:9060/ibm/console

Where server_node_name is the name or IP address of a
node computer where WebSphere is installed.

Leave the User ID box blank.

IBM Cognos Configuration

Use IBM Cognos
Configuration to configure
settings for IBM Cognos
Business Intelligence.

/opt/IBM/cognos/c10_64/bin64/cogconfig.sh

IBM Cognos Configuration is installed on the Business
Intelligence (BI) node computer.

IBM Cognos Connection

Use IBM Cognos Connection
to access reports.

IBM Cognos Administration

Use IBM Cognos
Administration to configure
IBM Cognos BI, such as add
data source connections and
set security.

http://bi_node_name/ibmcognos

Where bi_node_name is the name or IP address of BI node
computer.
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Table 21. Administration tool and product portal reference (continued)

Administration tool or portal
and description

URL or location

IBM SPSS Collaboration and
Deployment Services
Deployment Manager

Use IBM SPSS Collaboration
and Deployment Services
Deployment Manager to
configure IBM SPSS server
settings.

http://analytics_node_name:9080/config

Where analytics_node_name is the name or IP address of
Predictive Analytics node computer.

The default user name is admin.

The default password is admin.

IBM InfoSphere Master Data
Management Collaboration
Server

http://mdm_node_name:7507

Where mdm_node_name is the name or IP address of Master
Data Management (MDM) node computer.

The default user name is Admin. This value is case
sensitive.

The default password is trinitron. This value is case
sensitive.

You must also enter a company name. The default
company name is IBMPMQ.

Troubleshooting reports

Reports in IBM Predictive Maintenance and Quality are created in IBM Cognos
Report Studio. You may encounter problems when using some of the reports
included with IBM Predictive Maintenance and Quality.

For further information about troubleshooting reports, see the IBM Cognos Business
Intelligence Troubleshooting Guide, and the IBM Cognos Report Studio User Guide. This

is available from the web |[Cognos Business Intelligence documentation|

(http:/ /pic.dhe.ibm.com/infocenter/cbi/v10r2m0/index.jsp).

Slow response times for running the IBM Cognos Business

Intelligence reports

In some circumstances, you can experience slow response times for IBM Cognos
reports in the IBM Predictive Maintenance and Quality environment, particularly
for the Site overview reports. Slow response times happen when the DB2 database
contains large volumes of data, for example, if the EVENT OBSERVATION table
contains more than 3 million records.

About this task

To improve response times, create database indexes, and run runstats on the
indexes. You can get recommendations for the most appropriate actions to take by
running the db2advis command (DB2 Design Adviser).

Procedure

1. Create the EXPLAIN table with the following command: db2 -tvf
~/sq11ib/misc/EXPLAIN.DDL
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2. Bind the following files that are found in the sql1ib/bnd folder in the home
directory of the db2 user:
db2 bind db2advis.bnd blocking all grant public
db2 bind db2advworkload.bnd blocking all sqlerror continue grant public

db2 bind db2advworkload.bnd blocking all sqlerror continue grant public
db2 bind db2advis.bnd blocking all grant public

3. Run the db2advis command to get the recommendation by using the following

command:

db2advis -d <database name> -s "<sql of the Cognos report>" >recommendation.txt

Where

-d <database-name>
Specifies the name of the database to which a connection is to be
established.

-s "<sql of the Cognos report>"
Specifies the text of a single SQL statement to be assessed and have

indexes that are suggested by the DB2 Design Advisor. The statement

must be enclosed by double quotation marks.
What to do next

For more information, see the IBM DB2 documentation on the web:
lhttp:/ /pic.dhe.ibm.com/infocenter/db2luw /v9r7 /index.jsp| (http://
pic.dhe.ibm.com/infocenter/db2luw /v9r7 /index.jsp) and search for db2advis.

Correcting issues in the Site Overview dashboard

The health score in the Overview report, and the Contributors reports may have
blank values.

Procedure

1. In IBM Cognos Connection, open the Site overview dashboard from Public
Folder > IBMPMQ.

2. Open Query Explorer.
3. Right-click in the Query Explorer and select Manage Queries.

4. Right-click Overview, select Copy, then right-click and select Paste three
times.

5. Rename the queries by right-clicking each one and clicking Rename Query.
Rename them as follows:

* "Overviewl" to "HS For Day"
* "Overview2" to "HS For Resource"
e "Overview3" to "RC For Day"
6. Customize the queries listed in the following table:
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Table 22. Customizing queries in the Site Overview dashboard

Query Actions
HS For 1. Double-click HS For Day and remove all of the data items, except for the
Day following:
¢ Date
¢ Calendar Date
¢ Health Score
2. Open the Location ID from the Detail filters section and delete [Location
ID] from the Filter Expression window.
3. Drag the Location ID from the Location dimension into the Resource KPI
namespace in the Available Components pane. The resulting expression is:
[Resource KPI].[Location].[Location].[Location].
[Location ID] = ?Location?
4. Open the Resource Sub Type from the Detail filters section, and delete
[Resource Sub Type] from the filter expression window under the
Expression pane.
5. Drag the Resource Sub Type from the Resource dimension into the
Resource KPI namespace in the Available Components pane. The resulting
expression is:
[Resource KPI].[Resource].[Resource].[Resource].
[Resource Sub Type] = ?EquipmentType?
6. Drag the Health Score data item to the Detail Filters section.
7. Add the following expression:
[Health Score] is not null
HS For 1. Double-click HS For Resource and remove all of the data items, except for
Resource the following:
¢ Resource
* Date
¢ Calendar Date
¢ Health Score
2. Open the Location ID from the Detail filters section and delete [Location
ID] from the filter Expression window.
3. Drag the Location ID from the Location dimension into the Resource KPI
namespace in the Available Components pane. The resulting expression is:
[Resource KPI].[Location].[Location].[Location].
[Location ID] = ?Location?
4. Open the Resource Sub Type from the Detail filters section, and delete
[Resource Sub Type] from the filter expression window under the
Expression pane.
5. Drag the Resource Sub Type from the Resource dimension into the
Resource KPI namespace in the Available Components pane. The resulting
expression is:
[Resource KPI].[Resource].[Resource].[Resource].
[Resource Sub Type] = ?EquipmentType?
6. Drag the Incident Count data item to the Detail filters section.
7. Add the following expression:

[Health Score] is not null
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Table 22. Customizing queries in the Site Overview dashboard (continued)

Query Actions

RC For 1. Double-click RC For Day and remove all of the data items, except for the
Day following:

e Date

e Calendar Date

¢ Incident Count

* Recommendation Count

2. Open the Location ID from the Detail filters section and delete [Location
ID] from the Filter Expression window.

3. Drag the Location ID from the Location dimension into the Resource KPI
namespace in the Available Components pane. The resulting expression is:
[Resource KPI].[Location].[Location].[Location].

[Location ID] = ?Location?

4. Open the Resource Sub Type from the Detail filters section, and delete
[Resource Sub Type] from the Filter Expression window under the
Expression pane.

5. Drag the Resource Sub Type from the Resource dimension into the
Resource KPI namespace in the Available Components pane. The resulting
expression is:

[Resource KPI].[Resource].[Resource].[Resource].
[Resource Sub Type] = ?EquipmentType?

6. Drag the Incident Count data item to the Detail filters section.
7. Add the following expressions:

([Incident Count] is not null)and([Recommendation Count]
is not null)

7. Modify the properties for the HS for Day query:
¢ Open Page Explorer, and open the report page "Pagel".

* Select the conditional block, which is at the bottom of the report page body,
above the page footer. In the Properties pane of the Conditional Block,
under the Conditionalsection, change the Current Block value to 4. This
shows the Overview Charts in the report page body.

* Click the first bar chart, and in the chart Properties window, under Data,
change the Query value to HS For Day

* Select the conditional block, which is below the bar chart, and in the
Properties pane change the Current Block value to Yes. This shows the list
report.

* Select the List report.

* Select the conditional block by clicking the outside of the list. Change the
Current Block value to No in the Properties pane to hide the List report.

8. Modify the properties for the HS For Resource query:

* Click the second bar chart, and in the chart Properties window, under Data,
change the Query value to HS For Resource.

* Select the conditional block, which is below the bar chart, and in the
Properties pane change the Current Block value to Yes. This shows the List
report.

* Select the List report.
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10.

* In the Properties pane, in the Data section, change the Query value to HS
For Resource

* Select the conditional block by clicking the outside of the list. Change the
Current Block value to No in the Properties pane to hide the List report.

Modify the properties for the RC For Day query:

* Click the third bar chart, and in the chart Properties window, under Data,
change the Query value to RC For Day

e Select the conditional block, which is below the bar chart, and in the
Properties pane change the Current Block value to Yes. This shows the list
report.

* Select the List report.

* In the Properties pane, in the Data section, change the Query value to RC
For Day

¢ Select the conditional block by clicking the outside of the list. Change the
Current Block value to No in the Properties pane to hide the List report.

Save the changes and run the report.

Correcting drill-down issues in the Site overview dashboard

The Site overview dashboard sticks on the drill-down option. Drill-up is
intermittently disabled during this process.

Procedure

1. In IBM Cognos Connection, open the Site overview dashboard from Public
Folder > IBMPMQ.

2. Open Query Explorer and double-click Query KPI to see the list of member
sets type, and data items type.

3. Rename the Month member set type to Months.

4. From the Toolbox, create a new data item named Month with following
expression:

#prompt ('vDate', 'token','[Resource KPI].[Calendar].[Year].[Month]")#

5. Open Page Explorer and open the report page named Pagel.

6. Select the Conditional Block, which is at the bottom of the report page body,
above the page footer.

7. In the Properties pane of the Conditional Block, under the Conditional
section, change the Current Block value to 6. This value displays the KPI
trend chart in the report page body.

8. From the Toolbox, add a Value prompt to the KPI Trend chart, select Use
existing parameter, and the vDate parameter from the list, and click Finish.

9. Select the Value prompt, and in the Properties pane, add the following
expression to the Static Choices value:

[Resource KPI].[Calendar].[Year].[Month]
10. In the General section of the Properties pane, set Required to Yes, and set
Auto Submit to Yes.
11. Add the following expression to the Default Selections property:
[Resource KPI].[Calendar].[Year].[Month]
12. Hide the prompt so that it is not displayed to the user. In the Positioning
section of the Properties pane, set the Visible property to No.
13. Replace the Months data item with Month in a KPI chart at the X — axis.
14. Save the changes and run the report.
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Correcting drill-up issues in the Product quality dashboard

Drill-up does not work correctly in the Product quality dashboard. To correct this
problem, follow these steps.

Procedure

1.

10.

1.

12.

13.

14.

15.

16.

17.

In IBM Cognos Connection, open the Product quality dashboard from Public
Folder > IBMPMQ.

Open Query Explorer and select the query Material by process to see the list
of data items.

From the Toolbox, add a data item named Process with the following
expression:

#prompt ('ProcessHide', 'token','[Material Profile].[Process Hierarchy].
[Process Hierarchy].[Level 1 Process]')#

Add another data item named Material Type. Ensure that there is a double
space between Material and Type. Add the following expression:

#prompt ('MaterialTypeHide', 'token','[Material Profile].[Materials].
[Material By Type].[Material Type]')#

Open Page Explorer and open the report page "Pagel".

Select the Conditional Block which is at the bottom of the report page body,
above the page footer.

In the Properties pane of the Conditional Block, under the Conditional
section, change the Current Block value to 2. This value displays the Material
Usage By Process report in the report page body.

From the Toolbox, add a Value prompt to the Material Usage By Process
report. Select the Use existing parameter option, select the Process Hide
parameter from the list, and click Finish.

Select the Value prompt, and in the Properties pane, add the following
expression to the Static Choices value:

[Material Profile].[Process Hierarchy].[Process Hierarchy].[Level 1 Process]

In the General section of the Properties pane, set Required to Yes, and set
Auto Submit to Yes.

Add the following expression to the Default Selections property:
[Material Profile].[Process Hierarchy].[Process Hierarchy].[Level 1 Process]

From the Toolbox, add another Value prompt to the Material Usage By
Process report. Select the Use existing parameter option, select the
MaterialTypeHide parameter from the list, and click Finish.

Select the Value prompt, and in the Properties pane, add the following
expression to the Static Choices value:

[Material Profile].[Materials].[Material By Type].[Material Type]

In the General section of the Properties pane, set Required to Yes, and set
Auto Submit to Yes.

Add the following expression to the Default Selections property:
[Material Profile].[Materials].[Material By Type].[Material Type]

Hide the prompt so that it is not displayed to the user. In the Positioning
section of the Prompt Properties pane, set the Visible property to No.

Save the changes and run the report.
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Correcting drill-up issues in the Material usage by production
batch report

Drill-up does not work correctly in the Material usage by production batch report.
Follow these steps to correct this issue:

Procedure

1.

10.

In IBM Cognos Connection, open the Material usage by production batch
report from Public Folder > IBMPMQ.

Open Query Explorer and select the query
Query_measure_count_by_product_and_material to see the list of data items
for the query.

From the Toolbox, add a new data item named Material Type. Ensure that
there is a double space between Material and Type. Add the following
expression:

#prompt ('MaterialTypeHide', 'token','[Material Profile].[Materials].
[Material By Type].[Material Type]')#

Open Page Explorer and open the report page named "Pagel”

From the Toolbox, add a Value prompt to the Material usage by production
batch report. Select the Use existing parameter option, select the
MaterialTypeHide parameter from the list, and click Finish.

Select the Value prompt, and in the Properties pane, add the following
expression to the Static Choices value:

[Material Profile].[Materials].[Material By Type].[Material Type]

In the General section of the Properties pane, set Required to Yes, and set
Auto Submit to Yes.

Add the following expression to the Default Selections property:
[Material Profile].[Materials].[Material By Type].[Material Type]

Hide the prompt so that it is not displayed to the end user. In the Positioning
section of the Properties pane, set the Visible property to No.

Save the changes and run the report.

Correcting the logo in Predictive Maintenance and Quality
sample reports

The IBM logo in IBM Predictive Maintenance and Quality sample reports does not
display correctly. Correct this problem by copying the image to the Image folder in
the Installation directory.

Before you begin

You must first install the IBM Cognos Business Intelligence artifacts for IBM
Predictive Maintenance and Quality version 1 fix pack 1. For more information, see
the IBM Predictive Maintenance and Quality Installation Guide, and search for
“Updating the IBM Cognos BI artifacts for Fix Pack 1”.

Procedure

1.

Create a folder named Images under /opt/ibm/cognos/c10_64/webcontent/.

Note: Images must have an uppercase L.

Copy the IBM_logo_header.png file from /opt/IBM/PMQ/<BI time
stamp>/Reports/ and save it to /opt/ibm/cognos/cl0_64/webcontent/Images.
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3. On the Cognos server, open the Reusable Object Library report from Public
Folder, IBMPMQ.

4. Click the image item.

5. Under Image Property, URL Source, click the URL property to set the image
URL.

6. Replace the existing path with this one: ../Images/IBM_logo_header.png
7. Click OK, and save the report

What to do next

Run any report from Public Folder, IBMPMQ to verify that the IBM logo displays
correctly.
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Notices

This information was developed for products and services offered worldwide.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service. This document may
describe products, services, or features that are not included in the Program or
license entitlement that you have purchased.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
US.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing

Legal and Intellectual Property Law
IBM Japan Ltd.

19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law: INTERNATIONAL
BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE. Some states do not allow disclaimer of express or implied warranties in
certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Software Group
Attention: Licensing
3755 Riverside Dr.
Ottawa, ON

K1V 1B7

Canada

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

This Software Offering does not use cookies or other technologies to collect
personally identifiable information.
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Trademarks

IBM, the IBM logo and ibm.com are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at “ Ezoﬁgright and|
trademark information|” at www.ibm.com/legal/copytrade.shtml.

The following terms are trademarks or registered trademarks of other companies:

* Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

¢ Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo,
Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or
registered trademarks of Intel Corporation or its subsidiaries in the United States
and other countries.

* Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.

* UNIX is a registered trademark of The Open Group in the United States and
other countries.

* Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Oracle and/or its affiliates.
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